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1 E4428C Analog Signal Generator Overview

The following list shows the topics covered in this chapter:

o “Standard Analog Signal Generator Features’ on page 2
e “Options’ on page 3

e “Firmware Upgrades’ on page 3

e “Cdibration” on page 4

e “Maodes of Operation” on page 5

e “Front Panel Overview” on page 6

e “Front Panel Display” on page 12

e “Rear Panel Overview” on page 16
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Standard Analog Signal Generator Features

Standard Analog Signal Generator Features

CW output from 250 kHz to 3 or 6 GHz; the high-end frequency is dependent on the frequency option
purchased with your signal generator

list and step sweep of frequency and amplitude, with multiple trigger sources
user flatness correction

automatic leveling control (ALC) on and off modes; power calibration in ALC-off mode is available,
even without power search

10 MHz reference oscillator with external output

GPIB, RS-232, and 10Base-T LAN interfaces

closed-loop AM

dc-synthesized FM to 10 MHz rates, maximum deviation depends on the carrier frequency
phase modul ation

pulse modulation

afunction generator that includes the following features:

— 50€2 low frequency output, 0to 3V,

— selectable waveforms: sine, square, ramp, triangle, noise, swept-sine, dual-sine, and pulse
— variable frequency modulation rates

— variabletriggering in list and step sweep modes: auto, external, single, or remote

apulse generator that includes the following features:

— external pulse

— internal square wave

— internal pulse sources:. internal square, internal pulse, external 1 dc-coupled, and external 2
dc-coupled

— adjustable pulse width

— adjustable pulse period

— adjustable pulserate

external modulation inputs for AM, FM, and ®M

simultaneous modulation configurations
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Options

ESG signal generators have hardware, firmware, software, and documentation options. The data sheet
shipped with your signal generator provides an overview of available options. For more information, visit
the Agilent ESG web page at http://mwww.agilent.convfind/esg, selected the desired ESG model, and then
click the Options tab.

Firmware Upgrades

You can upgrade the firmware in your signal generator whenever new firmwareis released. New firmware
releases, which can be downloaded from the Agilent website, may contain signal generator features and
functionality not available in previous firmware releases.

To determine the availability of new signal generator firmware, visit the Signal Generator Firmware
Upgrade Center web page at http://www.agilent.conV/find/upgradeassistant, or call the number listed at
http: //mww.agilent.com/find/assist.

To Upgrade Firmware

The following procedure shows you how to download new firmware to your ESG using a LAN connection
and aPC. For information on equipment requirements and alternate methods of downloading firmware, such
as GPIB, refer to the Firmware Upgrade Guide, which can be accessed at

http: //mwww.agilent.com/find/upgradeassi stant.

1. NotethelP address of your signal generator. To view the IP address on the ESG, press Utility >
GPIB/RS-232 LAN > LAN Setup.

2. Usean internet browser to visit http://mwww.agilent.com/find/upgradeassistant.

3. Scroll down to the “ Documents and Downloads’ table and click the link in the “Latest Firmware
Revision” column for the E4428C/38C ESG.

4. Inthe File Download window, select Run.

5. In the Welcome window, click Next and follow the on-screen instructions. The firmware files download
to the PC.

6. Inthe“Documentsand Downloads’ table, click thelink in the “ Upgrade Assistant Software” column for
the E4428C/38C ESG to download the PSG/ESG Upgrade Assistant.

7. Inthe File Download window, select Run.

8. Inthe Welcome window, click 0K and follow the on-screen instructions.
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Calibration

9. At the desktop shortcut prompt, click Yes.

10. Oncethe utility downloads, close the browser and double-click the PSG/ESG Upgrade Assistant icon on the
desktop.

11. In the upgrade assistant, set the connection type you wish to use to download the firmware, and the
parameters for the type of connection selected. For LAN, enter the instrument’s | P address, which you
recorded in step 1.

NOTE If the PSG’s dynamic host configuration protocol (DHCP) is enabled, the network assigns
the instrument an I P address at power on. Because of this, when DHCP is enabled, the IP
address may be different each time you turn on the instrument. DHCP does not affect the
hostname.

12. Click Browse, and double-click the firmware revision to upgrade your signal generator.
13. In the Upgrade Assistant, click Next.

14. Once connection to the instrument is verified, click Next and follow the on-screen prompts.

NOTE Once the download starts, it cannot be aborted.
NOTE When the User Attention message appears, you must first cycle the instrument’s power,
then click OK.

When the upgrade compl etes, the Upgrade Assistant displays a summary.
15. Click 0K and close the Upgrade Assistant.

Calibration

Agilent Technol ogies recommends calibrating the E4428C ESG Signal Generator every two years.

4 Chapter 1



E4428C Analog Signal Generator Overview
Modes of Operation

Modes of Operation
The ESG signa generator provides three modes of operation:

* continuous wave (CW)
» swept signa
» analog modulation

Continuous Wave

In this mode, the signal generator produces a CW signal. The signal generator is set to a single frequency
and power level.

Swept Signal

In this mode, the signal generator sweeps over arange of frequencies and/or power levels. Both list and step
sweep functionality is available.

Analog Modulation

In this mode, the signal generator modulates the CW signal using one of four analog modulation types:

* AM (two paths)

* FM (two paths)

*  ®M (normal and high bandwidth)
e Pulse modulation
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Front Panel Overview

Figure 1-1 showsthe signal generator front panel. Thisinterface enables you to define, monitor, and manage
input and output characteristics.

Figure 1-1 Front Panel Feature Overview
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1. Display

The LCD screen provides information on the current function. Information can include status indicators,
frequency and amplitude settings, and error messages. Labels for the softkeys are located on the right-hand
side of the display. For further description of the front panel display, refer to “ Front Panel Display” on page
12.

2. Softkeys
Softkeys activate the function indicated by the displayed label to the left of each key.
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3. Frequency Key

Pressing this hardkey makes frequency the active function. You can change the RF output frequency or use
the menus to configure frequency attributes such as frequency multiplier, offset, and reference.

4. Amplitude Key

Pressing this hardkey activates the amplitude function. You can change the RF output amplitude or use the
menus to configure amplitude attributes such as power search, user flatness, and ALC BW.

b. Knob

Rotating the knob increases or decreases a numeric value or changes a highlighted digit or character. You
can also use the knob to step through lists or select itemsin arow. The knob uses the Incr Set value in
conjunction with the knob ratio (set with the Step/Knob Ratio softkey) to determine how much each turn of
the knob changes the active function value. For example, if the Incr Set value for the active function is 10 dB
and the knob ratio is 50 to 1, then each turn of the knob changes the active function by 0.2 dB (1/50th of

10 dB). By modifying either value or both, you change the amount for each turn of the knob. For more
information on softkeys, refer to the E4428C/38C ESG Sgnal Generators Key and Data Field Reference.

1. Save Key

Thishardkey accesses a menu of softkeys enabling you to save datato the signal generator’sinstrument state
memory register. The instrument state register is a section of memory divided into 10 sequences numbered O
through 9. Each sequence contains 100 registers numbered 00 through 99.

The Save hardkey provides a quick aternative to reconfiguring the signal generator viathe front panel or
with SCPI commands when switching between different configurations. The Recall hardkey recalls a saved
instrument state.

Refer to “Saving an Instrument State” on page 71 for more information on the save operation.
1. Menu Keys

These hardkeys access softkey menus enabling configuration of list and step sweeps, utility functions, the
LF output, and various analog modulation types. For detailed information on these keys, refer to the
E4428C/38C ESG Sgnal Generators Key and Data Field Reference.

8. Recall Key

This hardkey restores any instrument state that you previously saved in ainstrument state memory register.

Chapter 1 7



E4428C Analog Signal Generator Overview
Front Panel Overview

9. EXT 1 INPUT Connector
This BNC input connector accepts an input signal for use with AM, FM, ®M, and pulse modulation. The
damage levelsare 5 Vpgand 10V,

AM, FM, ®M 11V, produces the indicated deviation or depth. When using the AC coupled input selection with asignal that
has a peak input voltage that differs from 1V, by more than 3%, the signal generator displays HI/LO annunciator.

Pulse Modulation  +1Visonand 0V isoff

On signal generators with Option 1EM, thisinput is relocated to afemale BNC connector on the rear panel.

10. EXT 2 INPUT Connector

This BNC input connector accepts an input signal for use with AM, FM, ®M, and pulse modulation. The
damage levelsare 5 Vg and 10 V.

AM, FM, ®M 11V produces the indicated deviation or depth. When using the AC coupled input selection with asignal that
has a peak input voltege that differsfrom 1 V; by more than 3%, the signal generator displays HI/LO annunciator.

Pulse Modulation +1Visonand 0V isoff

On signal generators with Option 1EM, thisinput is relocated to afemale BNC connector on the rear panel.

11. Help Key

Press this key to display ashort description of any hardkey or softkey. There are two help modes available:
single and continuous. Single mode isthe factory preset condition. To toggle between single and continuous

mode, press Utility > Instrument Info/Help Mode > Help Mode Single Cont.

Single Mode The help text is provided for the next key you press without activating the key’s function. Any key pressed
afterward exits the help mode and activates the key’s function

Continuous Mode The help text is provided for each subsequent key press until you either press the Help key again, or change to
single mode. In continuous mode, pressing the Help key also activates the key’s function (except for the Preset key).
12. Trigger Key

This hardkey initiates an immediate trigger event for a function such asalist or step sweep. The trigger
mode must be set to Trigger Key prior to initiating a trigger event with this hardkey.

13. LF OUTPUT Connector

This BNC connector is the output for modulation signals generated by the low frequency (LF) source
function generator. This output is capable of driving 3V, (nominal) into a 502 load.

On signal generators with Option 1EM, this output is relocated to arear-panel female BNC connector.
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14. RF QUTPUT Connector

Thisfemale Type-N connector is the output for RF signals. The source impedance is 50Q. For Options 501,
502, 503, and 504 the damage levels are 50 Vdc, 50 W at < 2 GHz, and 25 W at > 2 GHz maximum. For
Options 501, 502, 503, and 504 the reverse power protection circuit will trip, however, at nominally 1 W.

CAUTION E4428C and E4438C signal generators with Option 506 are not equipped with reverse
power protection circuits.

On signal generators with Option 1EM, this output is relocated to arear-panel female Type-N connector.

15. Mod On/ Off Key

Pressing this hardkey enables or disables all active modulation formats (AM, FM, ®M, or Pulse) that are
applied to the output carrier signal.

This hardkey does not set up or activate an AM, FM, ®M, or Pulse format; each individual modulation
format must still be set up and activated (for example, AM > AM 0n) or nothing will be applied to the output
carrier signal when the Mod 0n/0ff hardkey is enabled.

The MCD QV GFF annunciator, which is always present on the display, indicates whether active modulation
formats have been enabled or disabled with the Mod On/0ff hardkey.

16. RF On/Off Key

This hardkey toggles the operating state of the RF signal present at the RF OUTPUT connector. The
RF On/ O f annunciator isalways visible in the display to indicate whether the RF is turned on or off.

17. Numeric Keypad

The numeric keypad consists of the 0 through 9 hardkeys, a decimal point hardkey, and a backspace hardkey
( ). The backspace hardkey enables you to backspace or specify a negative value. When specifying a
negative numeric value, the negative sign must be entered prior to entering the numeric value.

18. Incr Set Key

This hardkey enables you to set the increment value of the current active function. When this hardkey is
pressed, the increment value of the current active function appears as the active entry for the display. Use the
numeric keypad, arrow hardkeys, or the knob to adjust the increment value. Changing the Incr Set hardkey’s
value also affects how much each turn of the knob changes an active function’s value according to the
knob's current ratio setting. For more information on softkeys, refer to the E4428C/38C ESG Sgnal
Generators Key and Data Field Reference.
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19. Arrow Keys

The up and down arrow hardkeys are used to increase or decrease a numeric value, step through displayed
lists, or select itemsin arow of adisplayed list. Individual digits or characters may be highlighted using the
left and right arrow hardkeys. Once an individual digit or character is highlighted, its value can be changed
using the up and down arrow hardkeys.

20. Hold Key

This hardkey blanks the softkey label area, the active function area, and the text areas of the display.
Softkeys, arrow hardkeys, the knob, the numeric keypad, and the Incr Set hardkey have no effect once this
hardkey is pressed. Press any other hardkey to end the hold mode.

21. Return Key

This hardkey enables you to retrace your key presses. When in a menu with more than one level (More 1 of
3, More 2 of 3, etc.), the Return key will always return you to the first level of the menu.

22. Display Contrast Increase Key

This hardkey, when pressed or held, causes the display background to darken.

23. Display Contrast Decrease Key
This hardkey, when pressed or held, causes the display background to lighten.

24. Local Key

This hardkey is used to deactivate remote operation and return the signal generator to front panel control.

25. Preset Key

This hardkey is used to set the signal generator to a known state (factory or user-defined).

26. Standby LED

Thisyellow LED indicates when the signal generator power switch is set to the standby condition.

27. Line Power LED

This green LED indicates when the signal generator power switch is set to the on position.
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28. Power Switch

This switch activates full power to the signal generator when set to the on position, and deactivates all signal
generator functions when in standby mode. In standby mode, the signal generator remains connected to the
line power, and power is supplied to someinternal circuits.
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Front Panel Display

Figure 1-2 showsthe front panel display. The LCD screen displays datafields, annotations, key press results,
softkey labels, error messages, and annunciators that represent various active functions.

Figure 1-2 Front Panel Display
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The current frequency setting is shown in this portion of the display. In this same area, the ESG displaysthe
indicators for frequency offset (OFFS) and multiplier (MULT) functions. In addition, REF appears when you
enable the frequency reference mode and CHANNEL is turned on when you turn on a frequency channel
(Freq Channels Off On softkey).

L\
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1. Frequency Area
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2. Annunciators

The display annunciators show the status of some of the signal generator functions, and indicate error
conditions. An annunciator position may be used by more than one function. This does not create a problem,
because only one function that shares an annunciator position can be active at agiven time.

OM This annunciator appears when phase modulation is turned on. If frequency modulation
isturned on, the FMannunciator will replace ®M

ALC OFF This annunciator appears when the ALC circuit isdisabled. A second annunciator,
UNLEVEL, will appear in the same position if the ALC is enabled and is unable to
maintain the output level.

AM This annunciator appears when amplitude modulation is turned on.

ARVED This annunciator appears when a sweep has been initiated and the signal generator is
waiting for the sweep trigger event.

ATTEN HOLD This annunciator appears when the attenuator hold function is turned on. When this
function is on, the attenuator is held at its current setting.

ERR This annunciator appears when an error message is placed in the error queue. This
annunciator will not turn off until you have viewed all of the error messages or cleared
the error queue. You can access error messages by pressing Utility > Error Info.

EXT1 LO HI Thisannunciator isdisplayed aseither EXT1 LOor EXT1 H . Thisannunciator appears
when the ac-coupled signal to the EXT 1 INPUT islessthan 0.97 V|, or greater than

1.03V,,

EXT2 LO HI Thisannunciator isdisplayed aseither EXT2 LOor EXT2 H . Thisannunciator appears
when the ac-coupled signal to the EXT 2 INPUT islessthan 0.97 V, or greater than

1.03 V.
EXT REF This annunciator appears when an external frequency reference is applied.
FM This annunciator appears when frequency modulation isturned on. If phase modulation

isturned on, the ®Mannunciator will replace FM

L This annunciator appears when the signal generator isin listener mode and is receiving
information or commands over the GPIB, RS-232, or V XI-11/Sockets (LAN) interface.
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MOD ON OFF

OVEN CCLD

PULSE

RF ON OFF

SVEEP

UNLEVEL

UNLOCK

This annunciator indicates if the RF carrier is modulated (MOD ON whilethereisan
active modulation format), or if the modulation is off (MCD CFF). Either condition of
this annunciator is always visible in the display.

The MCD ONannunciator may be showing even when there are no active modulation
formats. This merely indicates that the carrier signal will be modulated when a
modulation format is enabled.

This annunciator appears when the temperature of the internal oven reference oscillator
has dropped below an acceptable level. When this annunciator is on, frequency
accuracy is degraded. This condition should occur for several minutes after the signal
generator isfirst connected to line power. The annunciator is timed, and automatically
turns off after a specified period.

This annunciator appears when pulse modulation is turned on.

This annunciator appears when the signal generator is remotely controlled over the
GPIB, RS-232, or VXI-11/Sockets (LAN) interface.

This annunciator indicates when the RF signal is present (RF ON) at the RF OUTPUT,
or if the RF signal is not present (RF CFF) at the RF OUTPUT. Either condition of this
annunciator is always visible in the display.

This annunciator appears when the signal generator has generated a service request
(SRQ) over the GPIB, RS-232, or V XI-11/Sockets (LAN) interface.

This annunciator appears when the signal generator is sweeping in list or step mode.

This annunciator appears when the signal generator isin talker mode and is transmitting
information over the GPIB, RS-232, or V X1-11/Sockets (LAN) interface.

This annunciator appears when the signal generator is unable to maintain the correct
output level. The UNLEVEL annunciator is not necessarily an indication of instrument
failure. Unleveled conditions can occur during normal operation. A second annunciator,
ALC CFF, will appear in the same position when the ALC circuit is disabled.

This annunciator appears when any of the phase locked loops are unable to maintain
phase lock. You can determine which loop is unlocked by examining the error

messages.
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3. Amplitude Area

The current output power level setting is shown in this portion of the display. When active, the following
functions also display indicators in the amplitude area:

Amplitude offset (CFFS)
Amplitude reference mode (REF)
Alternate Amplitude (A =0.00 dB)
User flatness (UF)

4. Softkey Label Area

Thelabelsin this area define the function of the softkeys located immediately to the right of the label. The
softkey label will change depending upon the function selected. For detailed softkey descriptions, refer to
the E4428C/38C ESG Sgnal Generators Key and Data Field Reference.

b. Error Message Area

Abbreviated error messages are reported in this space. When multiple error messages occur, only the most
recent message remains displayed. Reported error messages with details can be viewed by pressing
Utility > Error Info.

6. Text Area

Thisareaof the display is used to show status information about the signal generator such as the modulation
status, sweep lists, and file catalogs. This area aso enables you to perform functions such as managing
information, entering information, and displaying or deleting files.

7. Active Function Area

The current active function is shown in thisarea. For example, if frequency isthe active function, the current
frequency setting will be displayed here. If the current active function has an increment val ue associated
with it, that value is also displayed.
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Rear Panel Overview

Rear Panel Overview

and remote interface connections.

The signal generator rear panel (Figure 1-3) provides input, output

Figure 1-4 shows a portion of the rear panel for signal generators with Option 1EM, which moves front

panel connectors to the rear panel. For Option 1EM connectors not described in this section, see

“Front Panel Overview” on page 6.

Rear Panel Feature Overview

Figure 1-3
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1. AC Power Receptacle

The power cord receptacle accepts a three-pronged cable that is shipped with the signal generator. Theline
voltageis connected here.

2. GPIB Connector

The GPIB connector allows communications with compatible devices such as external controllers. It is
functionally equivalent to the LAN and RS 232 connectors.

3. RS 232 Connector

This female DB-9 connector is an RS-232 seria port that can be used for controlling the signal generator
remotely. It is functionally equivalent to the GPIB and LAN connectors. The following table shows the
description of the pinouts. Figure 1-5 shows the pin configuration.

Table 1-1 RS 232 Connector
Pin Number Signal Description Signal Name

1 No Connection
2 Receive Data RECV
3 Transmit Data XMIT
4 +5V
5 Ground, 0V
6 No Connection
7 Request to Send RTS
8 Clear to Send CTS
9 No Connection

Figure 1-5

5 40 3¢ 24 1o View looking into
O¢ 8¢ 7s 6be rear panel connector
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4. LAN Connector

LAN based communication is supported by the signal generator viathe LAN (local area network) connector.
The LAN connector enables the signal generator to be remotely programmed by a L AN-connected
computer. The distance between a computer and the signal generator islimited to 100 meters (10Base-T) on
asingle cable. For more information about the LAN, refer to the E4428C/38C ESG Sgnal Generators
Programming Guide.

b. TRIG OUT Connector

Thisfemale BNC connector outputsa TTL signal that is asserted high at the start of a dwell sequence, or at
the start of waiting for the point trigger in manual sweep mode. It is asserted low when the dwell is over,
when the point trigger is received, or once per sweep during an LF sweep. The logic polarity can be
reversed.

6. TRIG IN Connector

This female BNC connector accepts a CMOS signal for triggering operations, such as point-to-point in
manual sweep mode or an LF sweep in external sweep mode. Triggering can occur on either the positive or
negative edge. The damage levels are > +5.5 volts and < —0.5 volts.

7.10 MHz IN Connector

This female BNC connector accepts a—3.5 to +20 dBm signal from an external timebase referencethat is 1,
2,5, or 10 MHz +0.2 ppm. The nominal input impedance is 50Q2. The signal generator detects when avalid
reference signal is present at this connector and automatically switches from internal to external reference
operation. The signal generator will only automatically switch from internal to external reference operation
when the instrument isin its factory default mode where the Ref Oscillator Source Auto Off On softkey is set to
on.

8. SWEEP OUT Connector

This female BNC connector provides a voltage range of 0to +10 V. When the signal generator is sweeping,
the SWEEP OUT signal ranges from 0 V at the beginning of the sweep to +10 V at the end of the sweep
regardless of the sweep width. In CW mode this connector has no output. The output impedance is less than
1Q and can drive 2 kQ.

9. 10 MHz OUT Connector

This female BNC connector provides anominal signal level of +3.9 dBm £2 dB, and an output impedance
of 50Q. The accuracy is determined by the timebase used.
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E4438C Vector Signal Generator Overview

The following list shows the topics covered in this chapter:

“Standard Vector Signal Generator Features’ on page 20
“Options” on page 21

“Firmware Upgrades’ on page 22

“Calibration” on page 23

“Modes of Operation” on page 24

“Front Panel Overview” on page 26

“Front Panel Display” on page 33

“Rear Panel Overview” on page 37
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Standard Vector Signal Generator Features

CW output from 250 kHz to 1, 2, 3, 4 or 6 GHz; the high-end frequency is dependent on the frequency
option purchased with your signal generator

list and step sweep of frequency and amplitude, with multiple trigger sources
user flatness correction

automatic leveling control (ALC) on and off modes; power calibration in ALC-off mode is available,
even without power search

10 MHz reference oscillator with external output

GPIB, RS-232, and 10Base-T LAN interfaces

closed-loop AM

dc-synthesized FM to 10 MHz rates, maximum deviation depends on the carrier frequency
phase modul ation

pulse modulation

afunction generator that includes the following features:

— 50€2 low frequency output, 0to 3V,

— selectable waveforms: sine, square, ramp, triangle, noise, swept-sine, dual-sine, and pulse
— variable frequency modulation rates

— variabletriggering in list and step sweep modes: auto, external, single, or remote

apulse generator that includes the following features:

— external pulse

— internal square wave

— internal pulse sources:. internal square, internal pulse, external 1 dc-coupled, and external 2
dc-coupled

— adjustable pulse width

— adjustable pulse period

— adjustable pulserate

external modulation inputsfor AM, FM, ®M, and 1/Q modulation

simultaneous modulation configurations

20
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Options

ESG signal generators have hardware, firmware, software, and documentation options. The data sheet
shipped with your signal generator provides an overview of available options. For more information, visit
the Agilent ESG web page at http://mwww.agilent.convfind/esg, selected the desired ESG model, and then
click the Options tab.

Understanding Baseband Generator Options

Your E4438C can have one of four baseband generator options, depending upon when you first purchased
the instrument and whether or not the baseband generator has been upgraded to anewer version. The options
consist of the following:

Option 001 internal baseband generator with 8 megasample memory (no longer available)
Option 002 internal baseband generator with 32 megasample memory (no longer available)
Option 601 internal baseband generator with 8 megasample memory and digital bus capability
Option 602 internal baseband generator with 64 megasample memory and digital bus capability

These four baseband generators are similar in some respects, and very different in others. They aresimilar in
that all four versions support the same signal generation formats, such as W-CDMA, cdma2000, WLAN,
and many others. All four versions offer both arbitrary waveform capability and real-time baseband
generation capability.

Thefirst obvious difference between these four baseband generators is that they offer different playback
memory sizes. Thisis primarily important to users providing their own arbitrary waveform files, since these
may be very largein size. Of the signal creation personalities offered by Agilent, currently only Signal
Studio for WLAN and Signal Studio for Pulse Building are capable of creating waveforms that can exceed
the 8 megasample memory of the Option 001/601 models.

The second important difference between these baseband generators is that only Option 601 and 602 offer
digital bus capability. This proprietary digital busis used for communication with the Agilent Baseband
Studio suite of products. Baseband Studio products provide a range of baseband signal processing functions,
including baseband digital outputs, fading, and hard drive waveform streaming. These functions are not
compatible with Options 001 or 002. An upgrade kit is available, however, if you want to add Option 601 or
602 to your existing E4438C ESG.
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Firmware Upgrades

You can upgrade the firmware in your signal generator whenever new firmware is released. New firmware
rel eases, which can be downloaded from the Agilent website, may contain signal generator features and
functionality not available in previous firmware rel eases.

To determine the availability of new signal generator firmware, visit the Signal Generator Firmware
Upgrade Center web page at http://www.agilent.convfind/upgradeassistant, or call the number listed at
http: //wvww.agilent.com/find/assist.

To Upgrade Firmware

The following procedure shows you how to download new firmware to your ESG using aLAN connection
and aPC. For information on equipment requirements and alternate methods of downloading firmware, such
as GPIB, refer to the Firmware Upgrade Guide, which can be accessed at

http: //mww.agilent.com/find/upgradeassi stant.

1. Notethe IP address of your signal generator. To view the IP address on the ESG, press Utility >
GPIB/RS-232 LAN > LAN Setup.

2. Usean internet browser to visit http://mwww.agilent.convfind/upgradeassistant.

3. Scroll down to the “ Documents and Downloads’ table and click thelink in the “Latest Firmware
Revision” column for the E4428C/38C ESG.

4. Inthe File Download window, select Run.

5. In the Welcome window, click Next and follow the on-screen instructions. The firmware files download
to the PC.

6. Inthe“Documentsand Downloads’ table, click thelink in the “ Upgrade Assistant Software” column for
the E4428C/38C ESG to download the PSG/ESG Upgrade Assistant.

7. Inthe File Download window, select Run.
8. Inthe Welcome window, click 0K and follow the on-screen instructions.
9. At the desktop shortcut prompt, click Yes.

10. Oncethe utility downloads, close the browser and double-click the PSG/ESG Upgrade Assistant icon on the
desktop.

11. In the upgrade assistant, set the connection type you wish to use to download the firmware, and the
parameters for the type of connection selected. For LAN, enter the instrument’s | P address, which you
recorded in step 1.
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NOTE If the PSG’s dynamic host configuration protocol (DHCP) is enabled, the network assigns
the instrument an I P address at power on. Because of this, when DHCP is enabled, the IP
address may be different each time you turn on the instrument. DHCP does not affect the
hostname.

12. Click Browse, and double-click the firmware revision to upgrade your signal generator.
13. In the Upgrade Assistant, click Next.

14. Once connection to the instrument is verified, click Next and follow the on-screen prompts.

NOTE Once the download starts, it cannot be aborted.
NOTE When the User Attention message appears, you must first cycle the instrument’s power,
then click OK.

When the upgrade compl etes, the Upgrade Assistant displays a summary.
15. Click 0K and close the Upgrade Assistant.

Calibration

Agilent Technol ogies recommends calibrating the E4438C ESG Signal Generator every two years.
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Modes of Operation

The ESG signal generator provides four modes of operation:

* continuous wave (CW)
» swept signa

» analog modulation

» digital modulation

Continuous Wave

In this mode, the signal generator produces a CW signal. The signal generator is set to a single frequency
and power level.

Swept Signal

In this mode, the signal generator sweeps over arange of frequencies and/or power levels. Both list and step
sweep functionality is available.

Analog Modulation
In this mode, the signal generator modulates the CW signal using one of four analog modulation types:

* AM (two paths and wideband)

* FM (two paths)

*  ®M (normal and high bandwidth)
* Pulse modulation

Some of these modulation types can be used together.

Digital Modulation

In this mode, the signal generator modulates a CW signal with either areal-time 1/Q signal or arbitrary 1/Q
waveform. 1/Q modulation is only available on the E4438C. An optional interna baseband generator
(Option 001/601 002/602) adds the following digital modulation formats:

»  Custom Arb Waveform Generator mode can produce a single-modulated carrier or multiple-modul ated
carriers. Each modul ated carrier waveform must be cal culated and generated before it can be output; this
signal generation occurs on theinternal baseband generator. Once awaveform has been created, it can be
stored and recalled, which enables repeatabl e playback of test signals. To learn more, refer to “Using the
Arbitrary Waveform Generator” on page 386.
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Custom Real Time I/Q Baseband mode produces a single carrier, but it can be modulated with real-time
data that allows real-time control over all of the parameters that affect the signal. The single-carrier
signal that is produced can be modified by applying various data patterns, filters, symbol rates,
modulation types, and burst shapes. To learn more, refer to “Using the Real Time 1/Q Baseband
Generator” on page 392.

Multitone mode produces up to 64 continuous wave signals (or tones) with adjustable amplitude and
frequency spacing. To learn more, refer to “Multitone Waveform Generator (Options 001/601 or
002/602)" on page 379.

Dual ARB mode is used to control the playback sequence of waveform segments that have been written
into the ARB memory located on theinternal baseband generator. These waveforms can be generated by
theinternal baseband generator using any of the Arb modulation formats, or downloaded through a
remote interface into the ARB memory. To learn more, refer to “ Using the Dual ARB Waveform Player”
on page 107.
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Front Panel Overview

Figure 2-1 shows the signal generator front panel. Thisinterface enables you to define, monitor, and manage
input and output characteristics.

Figure 2-1 Front Panel Feature Overview
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The LCD screen provides information on the current function. Information can include status indicators,
frequency and amplitude settings, and error messages. Labels for the softkeys are located on the right-hand
side of the display. For further description of the front panel display, refer to “ Front Panel Display” on page
33.

pk70ic

1. Display

2. Softkeys
Softkeys activate the function indicated by the displayed label to the left of each key.

3. Frequency Key

Pressing this hardkey makes frequency the active function. You can change the RF output frequency or use
the menus to configure frequency attributes such as frequency multiplier, offset, and reference.
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4. Amplitude Key

Pressing this hardkey activates the amplitude function.

When active, the following functions also display indicators in the amplitude area:

«Amplitude offset (CFFS)
«Amplitude reference mode (REF)
Alternate Amplitude (A =0.00 dB)
eUser flatness (UF)

b. Knob

Rotating the knob increases or decreases a numeric value or changes a highlighted digit or character. You
can also use the knob to step through lists or select itemsin arow. The knob uses the Incr Set value in
conjunction with the knab ratio (set with the Step/Knob Ratio softkey) to determine how much each turn of
the knob changes the active function value. For example, if the Incr Set value for the active functionis 10 dB
and the knob ratio is 50 to 1, then each turn of the knob changes the active function by 0.2 dB (1/50th of

10 dB). By modifying either value or both, you change the amount for each turn of the knob. For more
information on softkeys, refer to the E4428C/38C ESG Sgnal Generators Key and Data Field Reference.

6. Menu Keys

These hardkeys access softkey menus enabling configuration of list and step sweeps, utility functions, the
LF output, and various analog and digital modulation types. For detailed information on these keys, refer to
the E4428C/38C ESG Sgnal Generators Key and Data Field Reference.

1. Save Key

This hardkey accesses a menu of softkeys enabling you to save instrument settings to the signal generator’s
instrument state memory register. The instrument state register is a section of memory divided into 10
sequences numbered 0 through 9. Each sequence contains 100 registers numbered 00 through 99.

The Save hardkey provides a quick alternative to reconfiguring the signal generator viathe front panel. The
Recall hardkey recalls a saved instrument state.

Refer to “ Saving an Instrument State” on page 71 for more information on the save operation.

8. Recall Key

This hardkey restores any instrument state that you previously saved in ainstrument state memory
register.When you load the waveform file from NVWFM into waveform memory (WFM1), and then use the
Recall softkey to recall the signal generator settings associated with thefile.
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9. EXT 1 INPUT Connector

This BNC input connector accepts an input signal for use with AM, FM, ®M, and pulse modulation, or as
the linear control for a burst envelope. The damage levelsare 5 Vg and 10V,

AM, FM, ®M 11 V|, produces the indicated deviation or depth. When using the AC coupled input selection with a
signal that has a peak input voltage that differs from 1 V, by more than 3%, the signal generator
displays the HI/LO annunciator.

Pulse Modulation +1Visonand OV isoff
Burst Envelope Provides linear control: —1 V = 0% amplitude and 0 V = 100% amplitude

On signal generators with Option 1EM, this input is relocated to a rear panel, male SMB connector.

10. EXT 2 INPUT Connector

This BNC input connector accepts an input signal for use with AM, FM, ®M, and pulse modulation. The
damage levelsare 5 Vg and 10 V.

AM, FM, ®M 11V, produces the indicated deviation or depth. When using the AC coupled input selection with a
signal that has a peak input voltage that differs from 1 V, by more than 3%, the signal generator
displays HI/LO annunciator.

Pulse Modulation +1V isonand OV isoff

If you configure your signal generator with Option 1EM, thisinput isrelocated to an SMB connector on the
rear panel.

11. Help Key

Press this key to display a short description of any hardkey or softkey. There are two help modes available:
single and continuous. Single mode is the factory preset condition. To toggle between single and continuous
mode, press Utility > Instrument Info/Help Mode > Help Mode Single Cont.

Single Mode The help text is provided for the next key you press without activating the key’s function. Any key
pressed afterward exits the help mode and activates the key’s function

Continuous Mode  The help text is provided for each subsequent key press until you either press the Help key again, or
change to single mode. In continuous mode, pressing the Help key also activates the key’s function
(except for the Preset key).

12. Trigger Key

This hardkey initiates an immediate trigger event for afunction such as alist or step sweep. Thetrigger
mode must be set to Trigger Key prior to initiating a trigger event with this hardkey.
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13. LF OUTPUT Connector

This BNC connector is the output for modulation signals generated by the low frequency (LF) source
function generator. This output is capable of driving 3V, (nominal) into a 502 load.

On signal generators with Option 1EM, this output relocated to arear-panel SMB connector.

14. RF OUTPUT Connector

Thisfemale Type-N connector isthe output for RF signals. The source impedance is 50Q. For Options 501,
502, 503, and 504 the damage levels are 50 Vdc, 50 W at < 2 GHz, and 25 W at > 2 GHz maximum. For
Options 501, 502, 503, and 504 the reverse power protection circuit will trip, however, at nominally 1 W.

CAUTION E4428C and E4438C signal generators with Option 506 are not equipped with reverse
power protection circuits.

On signal generators with Option 1EM, this output relocated to arear-panel female Type-N connector.

15. Mod On/Off Key

Pressing this hardkey enables or disables all active modulation formats (AM, FM, ®M, Pulse, or 1/Q) that
are applied to the output carrier signal.

This hardkey does not set up or activate an AM, FM, ®M, Pulse, or 1/Q format; each individual modulation
format must still be set up and activated (for example, AM > AM 0n) or nothing will be applied to the output
carrier signal when the Mod On/0ff hardkey is enabled.

The MCD QV GFF annunciator, which is always present on the display, indicates whether active modulation
formats have been enabled or disabled with the Mod On/0ff hardkey.

16. RF On/Off Key

This hardkey toggles the operating state of the RF signal present at the RF OUTPUT connector. The
RF On/ O f annunciator isalways visible in the display to indicate whether the RF is turned on or off.

17. Numeric Keypad

The numeric keypad consists of the 0 through 9 hardkeys, a decimal point hardkey, and a backspace hardkey
( ). The backspace hardkey enables you to backspace or specify a negative value. When specifying a
negative numeric value, the negative sign must be entered prior to entering the numeric value.
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18. Incr Set Key

This hardkey enables you to set the increment value of the current active function. When this hardkey is
pressed, the increment val ue of the current active function appears as the active entry for the display. Use the
numeric keypad, arrow hardkeys, or the knob to adjust the increment value. Changing the Incr Set hardkey’s
value al so affects how much each turn of the knob changes an active function’s value according to the
knob's current ratio setting. For more information on softkeys, refer to the E4428C/38C ESG Signal
Generators Key and Data Field Reference.

19. Arrow Keys

The up and down arrow hardkeys are used to increase or decrease a numeric value, step through displayed
lists, or select itemsin arow of adisplayed list. Individual digits or characters may be highlighted using the
left and right arrow hardkeys. Once an individua digit or character is highlighted, its value can be changed
using the up and down arrow hardkeys.

20. Hold Key

This hardkey blanks the softkey label area, the active function area, and the text areas of the display.
Softkeys, arrow hardkeys, the knob, the numeric keypad, and the Incr Set hardkey have no effect once this
hardkey is pressed. Press any other hardkey to end the hold mode.

21. Return Key

This hardkey enables you to retrace your key presses. When in a menu with more than one level (More 1 of
3, More 2 of 3, etc.), the Return key will always return you to the first level of the menu.

22. Display Contrast Increase Key

This hardkey, when pressed or held, causes the display background to darken.

23. Display Contrast Decrease Key
This hardkey, when pressed or held, causes the display background to lighten.

24. Local Key

This hardkey is used to deactivate remote operation and return the signal generator to front panel control.

25. Preset Key

This hardkey is used to set the signal generator to a known state (factory or user-defined).
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26. Standby LED

Thisyellow LED indicates when the signal generator power switch is set to the standby condition.

27. Line Power LED

This green LED indicates when the signal generator power switch is set to the on position.

28. Power Switch

Thisswitch activates full power to the signal generator when set to the on position, and deactivates al signa
generator functions when in standby mode. In standby mode, the signal generator remains connected to the
line power, and power is supplied to some internal circuits.

29. SYMBOL SYNC Connector (Option 001/601 or 002/602)

Thisfemale BNC input connector accepts an externally supplied symbol sync signal for use with digital
modul ation applications. The expected input isa CMOS bit clock signal. It may be used in two modes.
When used as a symbol sync in conjunction with a data clock, the signal must be high during the first data
bit of the symbol. The signal must be valid during the falling edge of the data clock signal and may be a
single pulse or continuous. When the SYMBOL SYNC itself is used as the (symbol) clock, the CMOS
falling edgeis used to clock the DATA signal.

The maximum clock rate is 50 MHz. The damage levels are > +5.5 volts and < —0.5 volts.

On signal generators with Option 1EM, thisinput isrelocated to arear panel SMB connector.

When using the real-time W-CDMA uplink personality, this connector should not be used to connect the
external baseband generator data clock. The BASEBAND GEN REF IN connector should be used instead.

30. DATA CLOCK Connector (Option 001/601 or 002/602)

The female BNC input connector accepts a CMOS externally supplied CMOS compatible signal data-clock
input used with digital modulation applications. The expected input isa CMOS bit clock signa where the
rising edge is aligned with the beginning data bit. The falling edge is used to clock the DATA and SYMBOL
SYNC signals.

The maximum clock rate is 50 MHz. The damage levels are > +5.5 volts and < —0.5 volts.

On signal generators with Option 1EM, thisinput isrelocated to arear panel SMB connector.
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31. DATA Connector (Option 001/601 or 002/602)

The female BNC input connector accepts a CMOS externally supplied CMOS compatible signal data input
used with digital modulation applications. The expected input isa CMOS signal whereaCMOS highis
equivalent to adatal and aCMOS low is equivalent to a data 0.

The maximum input data rate is 50 Mb/s.The data must be valid on the DATA CLOCK falling edges. The
damage levelsare > +5.5 voltsand < — 0.5 volts.

On signal generators with Option 1EM, thisinput isrelocated to arear panel SMB connector.

32. @ Connector
Thisfemale BNC input connector accepts an externally supplied, analog, quadrature-phase component of

I/Q modulation. The signal level is /IZ+Q2 = 0.5 Vs for acalibrated output level. The input impedance is
50Q. The damage level is1 Vs and 10 volts peak.

To activate asignal applied to this connector, press Mux > 1/Q Source 1 or 1/Q Source 2 and then select either
Ext 50 Ohm or Ext 600 Ohm. On signal generators with Option 1EM, thisinput is relocated as an SMB to the
rear panel.

33. 1 Connector

Thisfemale BNC input connector accepts an externally supplied, analog, in-phase component of 1/Q
modulation. The signal level is s =0.5 Vs for acalibrated output level. The input impedance is 502

To activate the in-phase component of the I/Q signal applied to this connector, press Mux > 1/Q Source 1 Or
1/Q Source 2 and then select either Ext 50 Ohm or Ext 600 Ohm.

Thisinput connector also accepts the modulating signal for use with the wideband AM selection. The
wideband AM signal depth isalinear function of the | INPUT signal voltage:

e 0.25volts=50%
* 0.5volts=100%

When turned on, wideband AM automatically selectsthe | INPUT and configuresit for 50Q. This setting is
independent of the MUX > 1/Q Source Setting.

The damage level for this connector is1 Vs and 10 volts peak. On signal generators with Option 1EM, this
input isrelocated as an SMB to the rear panel.
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Front Panel Display

Figure 2-2 showsthe front panel display. The LCD screen displays datafields, annotations, key press results,
softkey labels, error messages, and annunciators that represent various active functions.

Figure 2-2 Front Panel Display
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The current frequency setting is shown in this portion of the display. In this same area, the ESG displaysthe
indicators for frequency offset (OFFS) and multiplier (MULT) functions. In addition, REF appears when you
enable the frequency reference mode and CHANNEL is turned on when you turn on a frequency channel
(Freq Channels Off On softkey).
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2. Annunciators

The display annunciators show the status of some of the signal generator functions, and indicate error
conditions. An annunciator position may be used by more than one function. This does not create a problem,
because only one function that shares an annunciator position can be active at agiven time.

OM This annunciator appears when phase modulation is turned on. If frequency modulation
isturned on, the FMannunciator will replace ®M

ALC OFF This annunciator appears when the ALC circuit is disabled. Two other annunciators
appear in the same position;: UNLEVEL when the ALC is enabled and is unable to
maintain the output level, and BBG DAC when the waveform data exceeds the DAC

range.
AM This annunciator appears when amplitude modulation is turned on.
ARVED This annunciator appears when a sweep has been initiated and the signal generator is

waiting for the sweep trigger event.

ATTEN HOLD This annunciator appears when the attenuator hold function isturned on. When this
function is on, the attenuator is held at its current setting.

BERT This annunciator appears when the Option UN7 bit error rate test (BERT) functions are
turned on.

ENVLP This annunciator appearsif the burst envelope modulation is turned on.

ERR This annunciator appears when an error message is placed in the error queue. This

annunciator will not turn off until you have viewed all of the error messages or cleared
the error queue. You can access error messages by pressing Utility > Error Info.

EXT1 LO HI Thisannunciator isdisplayed aseither EXT1 LOor EXT1 H . Thisannunciator appears
when the ac-coupled signal to the EXT 1 INPUT islessthan 0.97 V|, or greater than

1.03V,,

EXT2 LO HI Thisannunciator isdisplayed aseither EXT2 LOor EXT2 H . Thisannunciator appears
when the ac-coupled signal to the EXT 2 INPUT islessthan 0.97 V, or greater than

1.03 V.
EXT REF This annunciator appears when an external frequency referenceis applied.
FM This annunciator appears when frequency modulation isturned on. If phase modulation

isturned on, the ®Mannunciator will replace FM

L This annunciator appears when the signal generator isin listener mode and is receiving
information or commands over the GPIB, RS-232, or V XI-11/Sockets (LAN) interface.
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This annunciator indicates if the RF carrier is modulated (MOD ON whilethereisan
active modulation format), or if the modulation is off (MCD CFF). Either condition of
this annunciator is always visible in the display.

The MCD ONannunciator may be showing even when there are no active modulation
formats. This merely indicates that the carrier signal will be modulated when a
modulation format is enabled.

This annunciator appears when the temperature of the internal oven reference oscillator
has dropped below an acceptable level. When this annunciator is on, frequency
accuracy is degraded. This condition should occur for several minutes after the signal
generator isfirst connected to line power. The annunciator is timed, and automatically
turns off after a specified period.

This annunciator appears when pulse modulation is turned on.

This annunciator appears when the signal generator is remotely controlled over the
GPIB, RS-232, or V XI-11/Sockets (LAN) interface.

This annunciator indicates when the RF signal is present (RF ON) at the RF OUTPUT,
or if the RF signal isnot present (RF CFF) at the RF OUTPUT. Either condition of this
annunciator is always visible in the display.

This annunciator appears when the signal generator has generated a service request
(SRQ) over the GPIB, RS-232, or V XI-11/Sockets (LAN) interface.

This annunciator appears when the signal generator is sweeping in list or step mode.

This annunciator appears when the signal generator isin talker mode and is transmitting
information over the GPIB, RS-232, or V X1-11/Sockets (LAN) interface.

This annunciator appears when the signal generator is unable to maintain the correct
output level. The UNLEVEL annunciator is not necessarily an indication of instrument
failure. Unleveled conditions can occur during normal operation. Two other
annunciators appear in the same position: ALC OFF when the ALC circuit is disabled
and BBG DAC when the waveform data exceeds the DAC range.

Thisannunciator appears when the waveform data exceeds the range of the DAC, which
causesaDAC over-rangeerror. It remainsilluminated until the condition is corrected by
scaling the data. It appearsin the same location as the UNLEVEL and ALC CFF
annunciators, and is the dominant annunciator. For example, if an unleveled condition
exists at the sametime asaDAC over-range condition, the DAC over-range annunciator
remains until corrected. Once corrected, the UNLEVEL annunciator appears.

This annunciator appears when any of the phase locked |oops are unable to maintain
phase lock. You can determine which loop is unlocked by examining the error

messages.
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3. Digital Modulation Annunciators

All digital modulation annunciators appear in this location. These annunciators appear only when the
modulation is active, and only one digital modulation can be active at any given time.

4. Amplitude Area

The current output power level setting is shown in this portion of the display. When active, the following
functions also display indicators in the amplitude area:

e Amplitude offset (OFFS)

» Amplitude reference mode (REF)
e Alternate Amplitude (A =0.00 dB)
e User flatness (UF)

5. Softkey Label Area

Thelabelsin this area define the function of the softkeys located immediately to the right of the label. The
softkey label will change depending upon the function selected. For detailed softkey descriptions, refer to
the E4428C/38C ESG Sgnal Generators Key and Data Field Reference.

6. Error Message Area

Abbreviated error messages are reported in this space. When multiple error messages occur, only the most
recent message remains displayed. Reported error messages with details can be viewed by pressing Utility >
Error Info.

7. Text Area

Thisareaof the display is used to show statusinformation about the signal generator such as the modulation
status, sweep lists, and file catalogs. This area also enables you to perform functions such as managing
information, entering information, and displaying or deleting files.

8. Active Function Area

The current active function is shown in thisarea. For example, if frequency isthe active function, the current
frequency setting will be displayed here. If the current active function has an increment val ue associated
with it, that valueis also displayed.
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The signal generator rear panel (Figure 2-3) provides input, output, and remote interface connections.

Figure 2-4 shows a portion of the rear panel for signal generators with Option 1EM, which moves front

panel connectors to the rear panel. For Option 1EM connectors not described in this section, see

“Front Panel Overview” on page 26.

Rear Panel Feature Overview
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1. 321.4 IN Connector (Option 300)

Use thisfemale SMB connector to input a downconverted 321.4 MHz GSM/EDGE signal for base
transceiver station (BTS) loopback measurements. (Option 300 also requires Options UN7, 001/6010r
002/602, and 402).

2. BER GATE IN Connector (Option UN7)

Use thisfemale SMB connector to input the clock gate signal for the bit-error-rate measurements. The clock
signal to the BER CLK IN connector is valid only when the signal to this connector is a high or low,
depending on your softkey selection or SCPI command. The damage levels are > +5.5 volts and < —0.5 volts.
This connector accepts a high impedance TTL-compatible signal or a 75Q input. It can be enabled or
disabled by a softkey or a SCPI command.

3. BER CLK IN Connector (Option UN7)

Use this female SMB connector to input the clock signal for the bit-error-rate measurements. Therising
(positive) or falling (negative) edge of the signal (selected either by softkey or SCPI command) causes data
on the BER DATA IN connector to be sampled. The damage levels are > +5.5 volts and < 0.5 volts. This
connector accepts a high impedance TTL-compatible signal or a 752 input.

4. BER DATA IN Connector (Option UN7)

Use thisfemale SMB connector to input the data streams for the bit-error-rate measurements. The rising
(positive) or falling (negative) edge of the BER CLK IN signal (selected by the softkey or the SCPI
command) is used to trigger the reading of the data. The damage levels are > +5.5 volts and < 0.5 valts. This
connector accepts a high impedance TTL-compatible signal or a 75Q input.

5. I-bar OUT Connector (Option 001/601 or 002/602)

Thisfemale BNC connector isused in conjunction with the | OUT connector to provide a bal anced baseband
stimulus. Balanced signals are signals present in two separate conductors that are symmetrical relative to
ground, and are opposite in polarity (180 degrees out of phase). The nominal output impedance of this
connector is 50, DC-coupled. The damage levelsare > +2 V and < -2 V. The DC origin offset istypically
<10 mV. The output signa levelsinto a 50€2 load are as follows:

« 0.5V, typical, corresponds to one unit length of the I/Q vector.

« 0.69Vy (2.84 dB), typical, maximum crest factor for peaks for n/4 DQPSK with alpha=0.5.
« 0.71Vyy (3.08 dB), typical, maximum crest factor for peaks for /4 DQPSK with alpha = 0.35.
* Typicaly 1V, , maximum (Option 001/601or 002/602 only).
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If you configure your signal generator with Option 1EM, thisoutput isrelocated and changed from aBNC to
an SMB connector.

6. 1 OUT Connector (Option 001/601 or 002/602)

Thisfemale BNC connector outputs the anal og, in-phase component of 1/Q modulation from the internal
baseband generator. The nominal output impedance of this connector is 502, DC-coupled. The damage
levelsare> +3.5V and < -3.5V. The DC origin offset istypically < 10 mV. The output signal levelsinto a
50Q load are asfollows:

* 0.5V, typical, corresponds to one unit length of the 1/Q vector.

+ 0.69Vy (284 dB), typical, maximum crest factor for peaks for n/4 DQPSK with alpha=0.5.
« 0.71Vy (3.08 dB), typical, maximum crest factor for peaks for n/4 DQPSK with alpha = 0.35.
« Typicaly 1V, maximum.

If you configure your signal generator with Option 1EM, this output is relocated from a BNC to an SMB
connector.

7. COH CARRIER Output Connector

The coherent carrier connector outputs RF that is modulated with FM or ®M. The output power isnominally
—2 dBm %5 dB. The output frequency range is from 249.99900001 MHz to the maximum specified
frequency of your signal generator or 4 GHz for Option 506 instruments. If the RF output frequency is
below this range, the coherent carrier output signal will have the following frequency: Frequency of
coherent carrier = (1E9 — Frequency of RF output) in Hz. The damage levelsare 20 Vdc and 13 dBm reverse
RF power.

8. @ OUT Connector (Option 001/601 or 002/602)

This female BNC connector outputs the anal og, quadrature-phase component of 1/Q modulation from the
internal baseband generator. The nominal output impedance of this connector is 50Q2, DC-coupled. The
damage levelsare> +3.5V and < -3.5 V. The DC origin offset is typically < 10 mV. The output signal
levelsinto a50Q load are as follows:

« 0.5V, typical, corresponds to one unit length of the 1/Q vector.

* 0.69Vy (2.84 dB), typical, maximum crest factor for peaks for /4 DQPSK with alpha=0.5.
* 0.71Vy (3.08dB), typical, maximum crest factor for peaks for n/4 DQPSK with alpha= 0.35.
+ Typicaly 1V, maximum.

If you configure your signal generator with Option 1EM, this output is relocated from a BNC to an SMB
connector.
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9. Q-bar OUT Connector (Option 001/601 or 002/602)

Thisfemale BNC connector is used in conjunction with the Q OUT connector to provide a balanced
baseband stimulus. Balanced signals are signals present in two separate conductors that are symmetrical
relative to ground, and are opposite in polarity (180 degrees out of phase). The nominal output impedance of
this connector is 50Q, DC-coupled. The damage levelsare > +2 V and < -2 V. The DC origin offset is
typically < 10 mV. The output signal levelsinto a50Q2 load are as follows:

* 0.5V, typical, corresponds to one unit length of the 1/Q vector.

« 0.69Vy (284 dB), typical, maximum crest factor for peaks for n/4 DQPSK with alpha=0.5.
« 0.71Vy (3.08 dB), typical, maximum crest factor for peaks for /4 DQPSK with alpha= 0.35.
+ Typicaly 1V, maximum.

If you configure your signal generator with Option 1EM, this output is relocated from a BNC to an SMB
connector.

10. EVENT 1 Connector (Option 001/601 or 002/602)

Thisfemale BNC connector outputs a pulse that can be used to trigger the start of a data pattern, frame, or
timedlot. It is adjustable to within plus or minus one timeslot with one bit of resolution. With Option 401
installed, an even second output is generated. A marker isoutput every two secondsindicating the beginning
of each short code sequence for use in synchronizing CDMA analysis instruments.

There isamarker on/off condition associated with each waveform point. The marker 1 level is+3.3V
CMOS high when positive polarity is selected; —3.3 V CMOS low when negative polarity is selected. The
output on the EVENT 1 connector occurs whenever Marker 1 isturned on in the waveform. (Markers are
automatically turned on whenever you set them in a waveform segment. When you combine waveform
segments that contain Marker 1 into a sequence, the markers are automatically turned off until you toggle
them on in either the Edit Selected Waveform Sequence menu or in the Build New Waveform Sequence
menu.)

The damage levelsfor the Event 1 connector are > +8 V and < —4 V. On signal generators with Option 1EM,
this output is changed from a BNC to an SMB connector. With Option 401 you can select from several
different output signals for this connector.

11. EVENT 2 Connector (Option 001/601 or 002/602)

This female BNC connector outputs a data enable signal for gating external equipment. The output is
applicable when the external datais clocked into internally generated timeslots. Data is enabled when the
signal islow. With Option 401 installed, a marker is output on the EVENT 2 connector every

26.67 milliseconds, corresponding to the start of each short code.

Thereisamarker on/off condition associated with each waveform point. The marker 2 level is+3.3V
CMOS high when positive polarity is selected; —3.3 V CMOS low when negative polarity is selected. The
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output on the EVENT 1 connector occurs whenever Marker 1 isturned on in the waveform.The output on
the EVENT 2 connector occurs whenever Marker 2 isturned on in the waveform. (Markers are
automatically turned on whenever you set them in a waveform segment. When you combine waveform
segments that contain Marker 2 into a sequence, the markers are automatically turned off until you toggle
them on in either the Edit Selected Waveform Sequence menu or in the Build New Waveform Sequence
menu.)

The damage levelsare > +8 V and < —4 V. On signal generators with Option 1EM, this output is changed
from a BNC to an SMB connector. With Option 401 this connector is used for system reset output.

12. PATT TRIG IN Connector (Option 001/601 or 002/602)

Thisfemale BNC input connector can accept either a CMOS low to CMOS high, or CMOS high to CMOS
low edge trigger. The minimum trigger input pulse width, high or low, is 100 ns. The damage levels are

> +5.5 volts and < —0.5 valts. If you configure your signal generator with Option 1EM, thisinput is
changed from a BNC to an SMB connector.

Theinput to the PATT TRIG IN connector is used to trigger the internal digital modulation pattern generator
to start a single pattern output or to stop and re-synchronize a pattern that is being continuously output. The
trigger edge is latched and then sampled by the falling edge of the internal data bit clock to synchronize the
trigger with the data bit clock timing. The minimum delay from the trigger edge to the first bit of the frame
is1.5t0 2.5 bit clock periods.

This connector is the source for the external trigger for all of the ARB waveform generator triggers. With
Option 401, this connector is used for even second synchronization input.

13. AUX 1/0 Connector

This female 37-pin connector is active only on instruments with an internal baseband generator (Option
001/601or 002/602). On signal generators without one of these options, this connector is non-functional.
This connector provides access to the inputs and outputs described in the following table and shown in
Figure 2-5.

Connector Pin Description

ALT PWRIN Pin-16 is used with an internal baseband generator. This pin accepts a CMOS signal for
synchronization of external data and alternate power signal timing. Damage levels are >
+5.5 voltsand < —-0.5 vaolts.

DATA CLK OUT Pin-6 is used with an internal baseband generator. This pin relays a CMOS bit clock
signal for synchronizing serial data. Damage levels are > +5.5 volts and < —0.5 volts.

DATA OUT Pin-7 is used with an internal baseband generator. This pin outputs data (CMOS) from
the internal data generator or the externally supplied signal at datainput. Damage levels
are> +5.5 voltsand < —0.5 volts.
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Connector Pin

Description (Continued)

EVENT 3

Pin-19 is used with an internal baseband generator. In arbitrary waveform mode, this pin
outputs atiming signal generated by Marker 3.

The marker 3 output level is+3.3 V CMOS regardless of marker polarity settings.The
reverse damage levels for this connector pin are > +5.5 volts and < —0.5 volts.

EVENT 4

Pin-18 isused with an internal baseband generator. In arbitrary waveform mode, this pin
outputs atiming signal generated by Marker 4.

The marker 4 output level is +3.3 V CMOS regardless of marker polarity settings. The
reverse damage levels for this connector pin are > +5.5 volts and < —0.5 volts.

PATT TRIGIN 2

Pin-17 accepts asignal that triggers an internal pattern or frame generator to start single
pattern output. Minimum pulse width is 100 ns. Damage levels are > +5.5 and < —-0.5 V.

SYM SYNC OUT

Pin-5 is used with an internal baseband generator. This pin outputs the CMOS symbol
clock for symbol synchronization, one data clock period wide. Damage levels are >
+5.5 voltsand < -0.5 volts.

BERMEASTRIG/BER
NO DATA

Pin-22 isused for bit error rate testing (Option UN7). Damage levels are > +5.5 volts
and < —-0.5 volts.

BER ERR OUT Pin-21 isused for bit error rate testing (Option UN7). Damage levels are > +5.5 volts
and < -0.5 volts

BER TEST OUT Pin-20 is used for hit error rate testing (Option UN7). Damage levels are > +5.5 volts
and < -0.5 volts

BER SYNC LOSS Pin-4 isused for bit error rate testing (Option UN7). Damage levels are > +5.5 volts and
<-0.5 volts.

BER MEAS END Pin-1isused for bit error rate testing (Option UN7). Damage levels are > +5.5 volts and
<-0.5 volts.
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Figure 2-5 AUX 1/0 Pin Configuration
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* Future Capability

14. DIGITAL BUS

Thisisaproprietary bus used for Agilent Baseband Studio products, which require Option 601 or 602. This
connector is not operational for general purpose customer use. Signals are present only when a Baseband
Studio option isinstalled (for details, refer to www.agilent.com/find/basebandstudio).

15. AC Power Receptacle

The power cord receptacle accepts a three-pronged cable that is shipped with the signal generator. Theline
voltage is connected here.
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16. GPIB Connector

The GPIB connector allows communications with compatible devices such as external controllers. It is
functionally equivalent to the LAN and RS 232 connectors.

17. RS 232 Connector

Thisfemale DB-9 connector is an RS-232 serial port that can be used for controlling the signal generator
remotely. It is functionally equivalent to the GPIB and LAN connectors. The following table shows the
description of the pinouts. Figure 2-6 shows the pin configuration.

Table 2-1 RS 232 Connector
Pin Number Signal Description Signal Name

1 No Connection
2 Receive Data RECV
3 Transmit Data XMIT
4 +5V
5 Ground, 0V
6 No Connection

Request to Send RTS
8 Clear to Send CTS
9 No Connection

Figure 2-6

5 40 3¢ 24 1o View looking into
Oe¢ 8¢ 78 6e rear panel connector

18. LAN Connector

LAN based communication is supported by the signal generator viathe LAN (local area network) connector.
The LAN connector enables the signal generator to be remotely programmed by a L AN-connected
computer. The distance between a computer and the signal generator islimited to 100 meters (10Base-T) on
asingle cable. For more information about the LAN, refer to the E4428C/38C ESG Signal Generators
Programming Guide.
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19. TRIG OUT Connector

Thisfemale BNC connector outputsa TTL signal that is asserted high at the start of a dwell sequence, or at
the start of waiting for the point trigger in manual sweep mode. It is asserted low when the dwell is over,
when the point trigger is received, or once per sweep during an LF sweep. The logic polarity can be
reversed.

20. BURST GATE IN Connector (Option 001/601 or 002/602)

The female BNC connector accepts a CMOS signal for gating burst power in digital modulation
applications. The burst gating is used when you are externally supplying data and clock information. The
input signal must be synchronized with the external datainput that will be output during the burst. The burst
power envelope and modulated data are internally delayed and re-synchronized. The input signal must be
CMOS high for normal burst RF power or CW RF output power and CMOS low for RF off. The leading
edges must be synchronous with the DATA CLOCK rising edges. The damage levels are > +5.5 volts and
<-0.5volts.

If you configure your signal generator with Option 1EM, this output is changed from a BNC to an SMB
connector. With Option 401, this connector is used for system reset trigger input.

21. TRIG IN Connector

This female BNC connector accepts a CMOS signal for triggering operations, such as point-to-point in
manual sweep mode or an LF sweep in external sweep mode. Triggering can occur on either the positive or
negative edge. The damage levels are > +5.5 volts and < —0.5 valts.

22. 10 MHz IN Connector

This female BNC connector accepts a—3.5 to +20 dBm signal from an external timebase referencethat is 1,
2,5, or 10 MHz +0.2 ppm. The nominal input impedance is 50Q2. The signal generator detects when avalid
reference signal is present at this connector and automatically switches from internal to external reference
operation. The signal generator will only automatically switch from internal to external reference operation
when the instrument isin its factory default mode where the Ref Oscillator Source Auto Off On softkey is set to
on.

23. SWEEP OUT Connector

This female BNC connector provides a voltage range of 0to +10 V. When the signal generator is sweeping,
the SWEEP OUT signal ranges from 0 V at the beginning of the sweep to +10 V at the end of the sweep
regardless of the sweep width. In CW mode this connector has no output. The output impedanceis|ess than
1Q and can drive 2 kQ.
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24. 10 MHz OUT Connector

Thisfemale BNC connector provides anominal signal level of +3.9 dBm +2 dB, and an output impedance
of 50Q. The accuracy is determined by the timebase used.

25. BASEBAND GEN REF IN Connector (Option 001/601 or 002/602)

The BASEBAND GEN REF IN connector accepts a0 to +20 dBm sine wave or TTL square wave signal
from an external timebase reference. This digital modulation reference clock is used by the internal
baseband generator for both component and receiver test applications (only the internal baseband generator
can be locked to this external reference; the RF frequency remains locked to the 10 MHz reference). The
nominal input impedance is 50Q at 13 MHz, AC-coupled.

This connector acceptsa TTL or >—10 dBm sine wave external reference at rates from 250 kHz through
100 MHz. Theinternal clock for the arbitrary waveform generator islocked to this signal when external
reference is selected in the ARB setup. The minimum pulse width must be > 10 ns. The damage levels are
>+8V and<-8V.

This female BNC connector is provided only on signal generators with Options 001/601 and 002/602. On
signal generators with Option 1EM, this output is changed from a BNC to an SMB connector.

When using the real-time W-CDMA uplink personality, this connector is used to connect the external
baseband generator data clock.
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3 Basic Operation

The following list shows the topics covered in this chapter:

“Using Table Editors’ on page 48

“Configuring the RF Output” on page 50

“Generating the Modulation Format” on page 58
“Modulating the Carrier Signal” on page 60

“Creating and Applying User Flatness Correction” on page 61
“Using the Memory Catalog” on page 68

“Using the Instrument State Registers’ on page 70

“Using Security Functions’ on page 75

“Enabling Options (E4438C Only)” on page 84

“Using the Web Server” on page 85
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Using Table Editors

The signal generator table editors enable you to simplify configuration tasks, such as creating alist sweep.
This section familiarizes you with basic table editor functionality using the List Mode Values table editor as

an example.

Press Preset > Sweep/Li

st > Configure List Sweep.

The signal generator displays the List Mode Values table editor, as shown below.

Figure 3-1
Active Function Area Cursor
\|
FREQUEMCY AMPLITY Edit Ttem
4.000 00000000 sz | =136.00 den
EHD Insert Row
Delete Rou
List MMode Ualues
Frequency Pouer Duell
M 1 HH= -20.00 dBm 100 ms Goto Rouy
2
p Insert Item
1] .
7 575.00000000 WHz
8 £90.00000000 Delste Item
9 575. 00000000
L 10 SE7.50000000 Mare
/ (1 of 23

Table Editor Name

Active Function Area

/

Table ltems Table Editor Softkeys

displays the active table item while its value is edited.

Cursor an inverse video identifier used to highlight specific table items for
selection and editing.

Table Editor Softkeys select table items, preset table values, and modify table structures.

Table Items values arranged in numbered rows and titled columns (The columns
are also known as datafields. For example, the column below the
Frequency title is known as the Frequency data field).
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Table Editor Softkeys

The following table editor softkeys are used to load, navigate, modify, and store table item values. Press
More (1 of 2) to access Load/Store and its associated softkeys.

Edit Item

Insert Row
Delete Row

Goto Row

Insert Item
Delete Item

Page Up and
Page Down

Load/Store

displays the selected item in the active function area of the display where the item’s
value can be modified.

inserts an identical row of table items above the currently selected row.
deletes the currently selected row.

opensamenu of softkeys (Enter, Goto Top Row, Goto Middle Row, Goto Bottom Row, Page Up,
and Page Down) used to quickly navigate through the table items.

inserts an identical item in anew row below the currently selected item.

deletes the item from the bottom row of the currently selected column.

displays table items that occupy rows outside the limits of the ten-row table display
area.

opens amenu of softkeys (Load From Selected File, Store To File, Delete File, Goto Row, Page
Up, and Page Down) used to load table items from afile in the memory catalog, or to
store the current table items as afile in the memory catalog. The signal generator
accepts afile name with a maximum length of 23 characters (alphanumeric and special
characters).

Modifying Table Items in the Data Fields

To modify existing table items:

1. Usethearrow keys or the knob to move the table cursor over the desired item. In Figure 3-1 on page 48,
thefirst item in the Frequency data field has been selected.

2. PressEdit Item.

The selected item is displayed in the active function area of the display.

3. Usetheknob, arrow keys, or the numeric keypad to modify the value.

4. PressEnter.

The modified item is now displayed in the table.

Chapter 3

49



Basic Operation
Configuring the RF Qutput

Configuring the RF Qutput

This section will show you how to create continuous wave and swept RF outputs.

Configuring a Continuous Wave RF Qutput
Using these procedures, you will learn how to set the following parameters:

* RF output frequency
» frequency reference and frequency offset
* RF output amplitude

« amplitude reference and amplitude offset

Setting the RF Output Frequency

1. PressPreset.

This returns the signal generator to the factory-defined state.

NOTE You can change the preset condition of the signal generator to auser-defined state. For these
examples, however, use the factory-defined preset state (the Preset Normal User softkey in
the Utility menu must be set to Normal).

2. Observe the FREQUENCY area of the display (in the upper left-hand corner).
The value displayed is the maximum specified frequency of the signal generator.
3. PressRF On/0ff.

The RF On/0ff hardkey must be pressed before the RF signal is available at the RF OUTPUT connector.
The display annunciator changes from RF OFF to R= ON. The maximum specified frequency is now
being output at the RF OUTPUT connector (at the signal generator’s minimum power level).

4. PressFrequency > 700 > MHz.

The 700 MHz RF frequency is now displayed in the FREQUENCY area of the display and also in the
active entry area.

5. PressFrequency > Incr Set > 1 > MHz.

This changes the frequency increment value to 1 MHz.
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Press the up arrow key.

Each press of the up arrow key increases the frequency by the increment value last set with the Incr Set
hardkey. The increment value is displayed in the active entry area.

The down arrow decreases the frequency by the increment value set in the previous step. Practice
stepping the frequency up and down in 1 MHz increments.

You can aso adjust the RF output frequency using the knob. Aslong as frequency is the active function
(the frequency is displayed in the active entry area), the knob will increase and decrease the RF output
frequency.

Use the knob to adjust the frequency back to 700 MHz.

Setting the Frequency Reference and Frequency Offset

The following procedure sets the RF output frequency as areference frequency to which all other frequency
parameters are relative. The frequency initially shown on the display will be 0. 00 Hz (the frequency output
by the hardware minus the reference frequency). Although the display changes, the frequency output does
not change. Any subsequent frequency changes are shown as incremental or decremental to 0 Hz.

1
2.
3.

Press Preset.
Press Frequency > 700 > MHz.
Press Freq Ref Set.

This activates the frequency reference mode and sets the current output frequency (700 MHz) as the
reference value. The FREQUENCY area displays 0. 00 Hz, which isthe frequency output by the
hardware (700 MHz) minus the reference value (700 MHz). The REF indicator is activated and the
Freq Ref Off On softkey has toggled to On.

Press RF On/Off.

The display annunciator has changed from RF OFF to RF O\ The RF frequency at the RF OUTPUT
connector is 700 MHz.

Press Frequency > Incr Set > 1 > MHz.
This changes the frequency increment value to 1 MHz.
Press the up arrow key.

This increments the output frequency by 1 MHz. The FREQUENCY area display changes to show
1.000 000 00 MHz, which isthe frequency output by the hardware (700 MHz + 1 MHZz) minus the
reference frequency (700 MHz). The frequency at the RF OUTPUT changesto 701 MHz.
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Press Freq Offset > 1 > MHz.

Thisentersa 1l MHz offset. The FREQUENCY areadisplays 2. 000 000 00 MHz, which isthe
frequency output by the hardware (701 MHZz) minus the reference frequency (700 MHz) plus the offset
(1 MHZz). The GFFSindicator is activated. The frequency at the RF OUTPUT connector is still

701 MHz.

Setting the RF Output Amplitude

Press Preset.
Observe the AMPLI TUDE area of the display.

The display reads the minimum power level of the signal generator. Thisisthe normal preset RF output
amplitude.

Press RF On/Off.

The display annunciator changes from R OFF to RF O\ The RF signal is now being output at the
minimum power level at the RF OUTPUT connector.

Press Amplitude > -20 > dBm.

This changes the amplitude to —20 dBm. The new —20 dBm RF output power is now displayed in the
AMVPLI TUDE area of the display and also in the active entry area.

Amplitudeis till the active function until you press another front panel function key. You can also
change the amplitude using the up and down arrow keys and the knob.

Setting the Amplitude Reference and Amplitude Offset

The following procedure sets the RF output power as an amplitude reference to which al other amplitude
parameters are relative. The amplitude initially shown on the display will be 0 dB (the power output by the
hardware minus the reference power). Although the display changes, the output power does not change. Any
subsequent power changes are shown as incremental or decremental to O dB.

1. PressPreset.

2. Press Amplitude > -20 > dBm.

3. PressMore (1 of 2) > Ampl Ref Set.
This activates the amplitude reference mode and sets the current output power (—20 dBm) as the
reference value. The AMPLI TUDE areadisplays 0. 00 dB, which isthe power output by the hardware
(20 dBm) minus the reference value (—20 dBm). The REF indicator is activated and the Ampl Ref Off On
softkey has toggled to On.
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4. Press RF On/0ff.

The display annunciator has changed from RF OFF to RF ON. The power at the RF OUTPUT connector
is—20 dBm.

5. Pressincr Set > 10 > dB.
This changes the amplitude increment value to 10 dB.
6. Usethe up arrow key to increase the output power by 10 dB.

The AMPLI TUDE area displays 10. 00 dB, which isthe power output by the hardware (—20 dBm plus
10 dBm) minus the reference power (—20 dBm). The power at the RF OUTPUT connector changes to
-10dBm.

7. Press Ampl Offset > 10 > dB.

This enters a 10 dB offset. The AMPLI TUDE area displays 20. 00 dB, which isthe power output by the
hardware (—10 dBm) minus the reference power (—20 dBm) plus the offset (10 dB). The OFFS indicator
is activated. The power at the RF OUTPUT connector is still =10 dBm.

Configuring a Swept RF OQutput

The signal generator has two sweep types: step and list.

NOTE List sweep data cannot be saved within an instrument state, but can be saved to the memory
catalog. For instructions on saving list sweep data, see “ Storing Files” on page 69.

During swept RF output, the FREQUENCY and AMPLI TUDE areas of the signal generator’s
display are deactivated, depending on what is being swept.

This section provides an explanation of the differences between step sweep and list sweep. You will learn
two ways to configure the signal generator’s RF output to sweep a defined set of frequency and amplitude
points. You will create a step sweep and then you will use these points as the basis for anew list sweep.

Step Sweep

When a step sweep is activated, the signal generator sweeps the RF output based on the values entered for
RF output start and stop frequencies and amplitudes, a number of equally spaced points (steps) to dwell
upon, and the amount of dwell time at each point. The frequency, amplitude, or frequency and amplitude of
the RF output will sweep from the start amplitude/frequency to the stop amplitude/frequency, dwelling at
equally spaced intervals defined by the # Points softkey value.

Step sweep provides alinear progression through the start-to-stop frequency and/or amplitude values. You
can toggle the direction of the sweep, up or down. When the Sweep Direction Down Up softkey is set to Up,
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values are swept from the start frequency/amplitude to the stop frequency/amplitude. When set to Down,
values are swept from the stop frequency/amplitude to the start frequency/amplitude.
Configuring and Activating a Single Step Sweep

In this procedure, you will create a step sweep with nine, equally spaced points and the following
parameters:

» frequency range from 500 MHz to 600 MHz
e amplitude from —20 dBm to 0 dBm
» dwell time 500 msat each point
1. PressPreset.
2. Press Sweep/List.

This opens amenu of sweep softkeys.
3. Press Sweep Repeat Single Cont.

This toggles the sweep repeat from continuous to single.
4. Press Configure Step Sweep.
5. PressFreq Start > 500 > MHz.

This changes the start frequency of the step sweep to 500 MHz.
6. PressFreq Stop > 600 > MHz.

This changes the stop frequency of the step sweep to 600 MHz.
7. Press Ampl Start > -20 > dBm.

This changes the amplitude level for the start of the step sweep.
8. Press Ampl Stop > 0 > dBm.

This changes the amplitude level for the end of the step sweep.
9. Press# Points > 9 > Enter.

This sets the number of sweep pointsto nine.
10. Press Step Dwell > 500 > msec.

This sets the dwell time at each point to 500 milliseconds.
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11. Press Return > Sweep > Freq & Ampl.

This sets the step sweep to sweep both frequency and amplitude data. Selecting this softkey returns you
to the previous menu and turns on the sweep function.

12. Press RF On/0ff.
The display annunciator changes from RF OFF to RF ONL
13. Press Single Sweep.

A single sweep of the frequencies and amplitudes configured in the step sweep is executed and available
at the RF OUTPUT connector. On the display, the SWEEP annunciator appears for the duration of the
sweep, and aprogress bar shows the progression of the sweep. The Single Sweep softkey can also be used
to abort a sweep in progress.

Activating Continuous Step Sweep

Press Sweep Repeat Single Cont.

Thistoggles the sweep from single to continuous. A continuous repetition of the frequencies and amplitudes
configured in the step sweep are now available at the RF OUTPUT connector. The SWEEP annunciator
appears on the display, indicating that the signal generator is sweeping, and progression of the sweep is
shown by a progress bar.

List Sweep

List sweep allowsyou to create alist of arbitrary frequency, amplitude, and dwell time values and sweep the
RF output based on the entries in the List Mode Values table.

Unlike a step sweep that contains linear ascending/descending frequency and amplitude values spaced at
equal intervals throughout the sweep, list sweep frequencies and amplitudes can be entered at unequal
intervals, nonlinear ascending/descending, or random order.

For convenience, the List Mode Values table can be copied from a previously configured step sweep. Each
step sweep point’s associated frequency, amplitude and dwell time values are entered into arow in the List
Mode Values table, asthe following example illustrates.

Configuring a List Sweep Using Step Sweep Data

In this procedure, you will leverage the step sweep points and change the sweep information by editing
several pointsin the List Mode Values table editor. For information on using table editors, see“Using Table
Editors’ on page 48.

1. Press Sweep Repeat Single Cont.

This toggles the sweep repeat from continuous to single. The SWEEP annunciator is turned off. The
sweep will not occur until it istriggered.
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Press Sweep Type List Step.
Thistoggles the sweep type from step to list.
Press Configure List Sweep.

This opens another menu displaying softkeys that you will use to create the sweep points. The display
shows the current list data. (When no list has been previously created, the default list contains one point
set to the signal generator’s maximum frequency, minimum amplitude, and a dwell time of 2 ms.)

Press More (1 of 2) > Load List From Step Sweep > Confirm Load From Step Sweep.

The points you defined in the step sweep are automatically loaded into the list.

Editing List Sweep Points

1

Press Return > Sweep > Off.

Turning the sweep off alows you to edit the list sweep points without generating errors. If sweep
remains on during editing, errors occur whenever one or two point parameters (frequency, power, and
dwell) are undefined.

Press Configure List Sweep.
Thisreturns you to the sweep list table.

3. Usethearrow keysto highlight the dwell timein row 1.

Press Edit Item.
The dwell time for point 1 becomes the active function.
Press 100 > msec.

This enters 100 ms as the new dwell time value for row 1. Note that the next item in the table (in this
case, the frequency value for point 2) becomes highlighted after you press the terminator softkey.

Using the arrow keys, highlight the frequency value in row 4.
Press Edit Item > 545 > MHz.

This changes the frequency valuein row 4 to 545 MHz.
Highlight any column in the point 7 row and press Insert Row.

This adds a new point between points 7 and 8. A copy of the point 7 row is placed between points 7 and
8, creating anew point 8, and renumbering the successive points.
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Highlight the frequency item for point 8, then press Insert Item.

Pressing Insert Item shifts frequency values down one row, beginning at point 8. Note that the original

frequency values for both points 8 and 9 shift down one row, creating an entry for point 10 that contains

only afrequency value (the power and dwell time items do not shift down).

The frequency for point 8 is still active.

10. Press 590 > MHz.

11. PressInsert Item > —2.5 > dBm.

Thisinserts anew power value at point 8 and shifts down the original power valuesfor points 8 and 9 by
one row.

12. Highlight the dwell time for point 9, then press Insert Item.

A duplicate of the highlighted dwell timeisinserted for point 9, shifting the existing value down to
complete the entry for point 10.

Activating List Sweep for a Single Sweep

1

Press Return > Sweep > Freq & Ampl

Thisturnsthe sweep on again. No errors should occur if all parametersfor every point have been defined
in the previous editing process.

Press Single Sweep.

The signal generator will single sweep the pointsin your list. The SWEEP annunciator activates during
the sweep.

Press More (1 of 2) > Sweep Trigger > Trigger Key.

This sets the sweep trigger to occur when you press the Trigger hardkey.
Press More (2 of 2) > Single Sweep.

This arms the sweep. The ARVED annunciator is activated.

Press the Trigger hardkey.

The signal generator will single sweep the pointsin your list and the SWEEP annunciator will be
activated during the sweep.
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Generating the Modulation Format

The modulation format can be turned on prior to or after setting your signal parameters. Perform the
following steps to turn the modul ation format on:

1. Accessthe first menu within the modulation format.

This menu will show a softkey that has the format’s name associated with off and on. For example, AM
0ff On. For some formats, the off/on key may appear in additional menus other than the first one.

2. Pressthe modulation format off/on key until On is highlighted.

Figure 3-2 shows the AM modulation format’sfirst menu with off asthe format status, and Figure 3-3 shows
an example of the ESG display when the format is active.

The modulation format is now generated, however the carrier signal is not modulated until the Mod On/ Off
key has been set to on. Depending on the modulation format, the signal generator may require afew seconds
to build the signal. Within the digital formats, you may see aBaseBand Reconfi guri ng status bar
appear on the display. Once the signal is generated, an annunciator showing the name of the format will
appear on the display indicating that the modulation format is active. For digital formats, thel / Q
annunciator will appear in addition to the name of the modulation format.

Figure 3-2 Modulation Format Off
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Figure 3-3 Modulation Format On
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Modulating the Carrier Signal

The carrier signa is modulated when the Mod On/0ff key is set to on and a modulation format is active.
When the key is set to on, the MOD ONannunciator shows in the display. The MOD CFF annunciator appears
when the key is set to off. The MOD CNannunciator may be showing even when there are no active
modulation formats. Thisjust indicatesthat the carrier signal will be modulated when amodulation format is
turned on.

To Turn the Modulation On

Press the Mod On/0ff key until the MCD QN annunciator appearsin the display.

The carrier signal is now modulated with all active modulation formats. Thisis the factory default.

To Turn the Modulation Off

Press the Mod On/0ff key until the MOD COFF annunciator appears in the display.

The carrier signal is no longer modulated or capable of being modul ated when amodulation format is active.

Figure 3-4 Carrier Signal Modulation Status
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Creating and Applying User Flatness Correction

User flatness correction alows the digital adjustment of RF output amplitude for up to 1601 frequency
pointsin any frequency or sweep mode. Using an Agilent E4416A/17A or E4418B/19B power meter
(controlled by the signal generator through GPIB) to calibrate the measurement system, atable of power
level correctionsis created for frequencies where power level variations or losses occur. These frequencies
may be defined in sequential linear steps or arbitrarily spaced.

If you do not have an Agilent E4416A/17A or E4418B/19B power meter, or if your power meter does not
have a GPIB interface, the correction values can be manually entered into the signal generator.

To alow different correction arrays for different test setups or different frequency ranges, you may save
individual user flatness correction tables to the signal generator’s memory catalog and recall them on
demand.

Follow the stepsin the next sections to create and apply user flatness correction to the signal generator’s RF
output.

Afterward, follow the stepsin “Recalling and Applying a User Flatness Correction Array” on page 66 to
recall auser flatness file from the memory catalog and apply it to the signal generator’s RF output.

Creating a User Flatness Correction Array

In this example, you will create a user flatness correction array. The flatness correction array contains ten
frequency correction pairs (amplitude correction values for specified frequencies), from 500 MHz to 1 GHz.

An Agilent E4416A/17A/18B/19B power meter (controlled by the signal generator via GPIB) and E4413A
power sensor are used to measure the RF output amplitude at the specified correction frequencies and
transfer the results to the signal generator. The signal generator reads the power level data from the power
meter, calculates the correction values, and stores the correction pairsin the user flatness correction array.

If you do not have the required Agilent power meter, or if your power meter does not have a GPIB interface,
you can enter correction values manually.

Required Equipment

* Agilent E4416A/17A/18B/19B power meter
» Agilent E4413A E Series CW power sensor
* GPIB interface cable

» adapters and cables, as required
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Configure the Power Meter

1. Select SCPI asthe remote language for the power meter.

2. Zero and calibrate the power sensor to the power meter.

3. Enter the appropriate power sensor calibration factors into the power meter as appropriate.
4

Enable the power meter’s cal factor array.

NOTE For operating information on your particular power meter/sensor, refer to its operating
guide.

Connect the Equipment

Connect the equipment as shown in Figure 3-5 on page 63.

NOTE During the process of creating the user flatness correction array, the power meter is
controlled by the signal generator via GPIB. No other controllers are allowed on the GPIB
interface.
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Figure 3-5 User Flatness Correction Equipment Setup
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Configure the Signal Generator

1. PressPreset.

2. Configure the signal generator to interface with the power meter.

a. Press Amplitude > More (1 of 2) > User Flatness > More (1 of 2) > Power Meter > E4416A, E4417A, E4418B,
or E4419B.

b. Press Meter Address > enter the power meter’'s GPIB address > Enter.

c. For E4417A and E4419B power meters, press Meter Channel A B to select the power meter’s active
channel.

d. Press Meter Timeout to adjust the length of time before the instrument generates atimeout error if
unsuccessfully attempting to communicate with the power meter.

3. Press More (2 of 2) > Configure Cal Array > More (1 of 2) > Preset List > Confirm Preset.

This opens the User Flatness table editor and presets the cal array frequency/correction list.
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9.

Press Configure Step Array.

This opens a menu for entering the user flatness step array data.

Press Freq Start > 500 > MHz.

Press Freq Stop > 1 > GHz.

Press # of Points > 10 > Enter.

Steps 4, 5, and 6 enter the desired flatness-corrected frequenciesinto the step array.

Press Return > Load Cal Array From Step Array > Confirm Load From Step Sweep.

This populates the user flatness correction array with the frequency settings defined in the step array.

Press Amplitude > 0 > dBm.

10. Press RF On/Off.

This activates the RF output and the RF ON annunciator is displayed on the signal generator.

Perform the User Flatness Correction

NOTE If you are not using an Agilent E4416A/17A/18B/19B power meter, or if your power meter

does not have a GPIB interface, you can perform the user flatness correction manually. For
instructions, see “Performing the User Flatness Correction Manually” on page 65.

1

Press More (1 of 2) > User Flatness > Do Cal.

This creates the user flatness amplitude correction value table entries. The signal generator enters the
user flatness correction routine and a progress bar is shown on the display.

When prompted, press Done.
This loads the amplitude correction valuesinto the user flatness correction array.
If desired, press Configure Cal Array.

This opens the user flatness correction array, where you can view the stored amplitude correction values.
The user flatness correction array title displays User Fl at ness: ( UNSTORED) indicating that the
current user flatness correction array data has not been saved to the memory catal og.
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Performing the User Flatness Correction Manually

If you are not using an Agilent E4416A/17A/18B/19B power meter, or if your power meter does not have a
GPIB interface, complete the steps in this section and then continue with the user flatness correction tutorial .

1. PressMore (1 of 2) > User Flatness > Configure Cal Array.

This opens the User Flatness table editor and places the cursor over the frequency value (1 GHz) for
row 1. The RF output changes to the frequency value of the table row containing the cursor and
1. 000 000 000 00 isdisplayed in the FREQUENCY area of the display.

Observe and record the measured value from the power meter.
Subtract the measured value from 0 dBm.

Move the table cursor over the correction valuein row 1.

a A~ WD

Press Edit Item > enter the difference value from step 3 > dB.

The signal generator adjusts the RF output amplitude based on the correction value entered.

IS

Repeat steps 2 through 5 until the power meter reads 0 dBm.

7. Usethe down arrow key to place the cursor over the frequency value
for the next row. The RF output changes to the frequency value of the table row containing the cursor, as
shown in the FREQUENCY area of the display.

8. Repeat steps 2 through 7 for every entry in the User Flatness table.

Save the User Flatness Correction Data to the Memory Catalog

This process allows you to save the user flatness correction datain the signal generator’s memory catal og.
With several user flatness correction files saved to the memory catalog, any file can be recalled, loaded into
the correction array, and applied to the RF output to satisfy specific RF output flatness requirements.

1. PressLoad/Store.

2. Press Store to File.

3. Enter the file name FLATCAL1 using the al phanumeric softkeys, numeric keypad, or the knob.
The maximum file name length is 23 characters (a phanumeric and special characters).

4. PressEnter.

The user flatness correction array file FLATCALL is now stored in the memory catalog asa UFLT file.
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Applying a User Flatness Correction Array
Press Return > Return > Flatness Off On.

This applies the user flatness correction array to the RF output. The UF indicator is activated in the
AMPLI TUDE section of the signal generator’s display and the frequency correction data contained in the
correction array is applied to the RF output amplitude.

Recalling and Applying a User Flatness Correction Array

Before performing the stepsin this section, complete “ Creating a User Flatness Correction Array” on
page 61.

1. PressPreset.

2. Press Amplitude > More (1 of 2) > User Flatness > Configure Cal Array > More (1 of 2) >
Preset List > Confirm Preset.

3. PressMore (2 of 2) > Load/Store.
4. Ensurethat the file FLATCAL1 is highlighted.
5. PressLoad From Selected File > Confirm Load From File.

This populates the user flatness correction array with the data contained in the file FLATCAL1. The user
flatness correction array title displays User Fl at ness: FLATCALL.

6. PressReturn > Flatness Off On.

This applies the user flatness correction data contained in FLATCAL 1.

Returning the Signal Generator to GPIB Listener Mode

During the user flatness correction process, the power meter is controlled by the signal generator via GPIB,
and no other controllers are allowed on the GPIB interface. The signal generator operatesin GPIB talker
mode, as a device controller for the power meter. In this operating mode, it cannot receive SCPI commands
viaGPIB.

NOTE Before interfacing the signal generator to aremote controller, the signal generator must be
in GPIB listener mode. Press the GPIB Listener Mode softkey to return the signal generator to
GPIB listener mode from GPIB talker mode.

If an RF carrier has been previously configured, you must save the present instrument state
before returning the signal generator to GPIB listener mode.

1. Saveyour instrument state to the instrument state register.

For instructions, see “ Saving an Instrument State” on page 71.
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2. PressGPIB Listener Mode.

This presets the signal generator and returnsit to GPIB listener mode. The signal generator can now
receive remote commands executed by a remote controller connected to the GPIB interface.

3. Recdl your instrument state from the instrument state register.

For instructions, see “Recalling an Instrument State” on page 72.
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Using the Memory Catalog

The signal generator’s interface for stored files isthe memory catalog. From the memory catalog, you can
view, store, and save files using the signal generator’s front panel or aremote controller. For more
information on the memory catalog and performing these tasks remotely, see the E4428C/38C ESG SCPI
Command Reference and the E4428C/38C ESG Vector Sgnal Generator Programming Guide.

The memory catalog may contain the following file types and their associated data:
BI N binary data

LI ST sweep data from the List Mode Values table including frequency, amplitude, and dwell
time
STAT instrument state data (controlling instrument operating parameters, such as frequency,

amplitude, and mode)

UFLT user flatness calibration correction pair data (user-defined frequency and corresponding
amplitude correction values)

NOTE You may have additional file types depending on which options you have installed in your
signal generator.

Viewing Stored Files

1. Press Utility > Memory Catalog > Catalog Type.

All filesin the memory catalog are listed in a phabetical order, regardliess of which catalog type you
select. File information appears on the display and includes the file name, file type, file size, and thefile
modification date and time.

2. Presslist
The Catalog of List Filesisdisplayed.
3. PressCatalog Type > State.
The Catalog of State Filesis displayed.
4. Press Catalog Type > User Flatness.
The Catalog of USERFLAT Filesis displayed.

68 Chapter 3



Basic Operation
Using the Memory Catalog

Storing Files

To store afile to the memory catalog, first create afile. For this example, use the default list sweep table.

1
2.

Press Preset.

Press Sweep/List > Configure L1ist Sweep > More (1 of 2) > Load/Store.
This opensthe Catalog of List Files.

Press Store to File.

This displays amenu of aphabetical softkeysfor naming thefile. St or e t o: isdisplayed in the active
function area.

Enter the file name LI ST1 using the alphabetical softkeys and the numeric keypad.
The maximum file name length is 23 characters (a phanumeric and special characters).
Press Enter.

Thefileis now displayed in the Catalog of List Files, showing the file name, file type, file size, and the
date and time the file was modified.
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Using the Instrument State Registers

The instrument state memory is a section of memory divided into 10 sequences (numbered 0 through 9).
Each sequence consists of 100 registers (numbered 00 through 99). Instrument state sequences and registers
save and recall signal generator settings, and provide a quick way to reconfigure the signal generator when
switching between different instrument and signal configurations.

The signal generator with Option 005 (internal hard drive) has approximately 4 GB available for storing
instrument state files, aswell as other user data. Without Option 005, the signal generator has 20 MB
available for data and instrument state storage. Instrument state files vary in length, depending on the signal
generator’s configuration.

Data, such aswaveform files, arb settings, and table entries, are not stored in instrument state memory. Store
these data types to the signal generator’s memory. Instrument state memory only saves settings such as
frequency, attenuation, power, and so forth.

The following list shows additional signal generator settings that are not saved with the save operation.

FM Deviation List Mode Freq Hostname FTP Server

RS-232 Baud Rate List Mode Power IP Address Web Server (HTTP)
Remote Language List Mode Dwell Subnet Mask Sockets SCPI (TELNET)
System Security Level List Mode Sequence  Default Gateway  VXI-11 SCPI

System Security Level Display  Display State On/Off MAC

System Security Level State PM Deviation Manual DHCP

Waveform datais stored in NVWFM. If you have awaveform file and want to save signal generator settings
associated with that file, you must first select the waveform in volatile waveform memory (WFM1). When
you save the signal generator settings associated with that file to instrument state memory, areferenceto the
waveform file name will also be saved. Refer to “ Storing and Loading Waveform Segments” on page 113
for information on saving waveform files.

For more information on storing file data, such as waveform files, arb setups, and table entries, refer to
“Storing Files’ on page 69. Refer to the E4428C/38C ESG Signal Generator Programming Guide and the
E4428C/38C ESG Sgnal Generator Key and Data Field Reference for more information on the save and
recall function.

The following procedure demonstrates saving settings to the instrument state memory.
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Saving an Instrument State

1.

Preset the signal generator, then turn on amplitude modulation (the AMannunciator will turn on):

a. PressFrequency > 800 > MHz.
b. Press Amplitude > 0 > dBm.
C. PressAM > AM Off On.

(Optional) If you want to associate these settings with awaveform file, load the waveform file into
WFM1 and select it. Refer to “ Storing and Loading Waveform Segments’ on page 113 for information
on loading waveform filesinto WFM 1.

Press Save > Select Seq > 1 > Enter.

The sequence number becomes the active function. The signal generator displays the last sequence used.
Using the arrow keys, set the sequenceto 1.

Press Select Reg > 1 > Enter.

The register number in sequence 1 becomes the active function. The signal generator displays either the
last register used accompanied by thetext: (i n use), or (if no registers are in use) register 00
accompanied by thetext: (avai | abl e) . Usethe arrow keysto select register 01.

Press Save Seq[1] Reg[01].

This saves the instrument state, configured in step 1, to sequence 1, register 01 of the instrument state
register. If awaveformis selected or being played, then the name of the waveform file will also be saved
in sequence 1, register 01 of the instrument state register.

Press Add Comment to Seq[1] Reg[01].

This enables you to add a descriptive comment to sequence 1 register 01. The comment appearsin the
Saved States list when the Recall hardkey is pressed. If you have a waveform associated with the
instrument state, enter the name of the waveform in the comment field. You can then easily identify the
name of the waveform and associated instrument state when the Recall hardkey is pressed.

Using the letter softkeys, front panel knob, or numeric keypad, enter acomment and press Enter.
Press Edit Comment In Seq[1] Reg[01].

If you wish, you can now change the descriptive comment for sequence 1 register O1.

Changesto apreviously saved instrument state, for example an instrument state saved in Seq n, Reg nn, can
be re-saved by highlighting that register and pressing Re-SAVE Seq[n] Reg[nn]. The re-save function
overwrites previously saved instrument state settings, with the new settings configuration.
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Recalling an Instrument State

Using this procedure, you will learn how to recall instrument settings saved to an instrument state register.
Refer to the “Recalling an Instrument State for a Waveform File” on page 73 for recalling awaveform file
and associated signal generator settings.

1. PressPreset.
2. Pressthe Recall hardkey.
Notice that the Select Seq softkey shows sequence 1. (Thisisthe last sequence that you used.)
3. PressRECALL Reg.
The register to be recalled in sequence 1 becomes the active function. Press the up arrow key once to

select register 1. Your stored instrument state settings are recalled.

Saving an Instrument State for a Waveform File

This procedure applies to the E4438C with Option 001/601 or 002/602 and demonstrates saving signal
generator settings associated with awaveform file.

NOTE The save function saves only areference to awaveform file name; no waveform datais
stored. Use Save function to save signal generator settings and use the Store function to
save waveform data.

Signal generator settings such as frequency, power, attenuator level, and so forth, are not saved when a
waveform fileis saved. Signal generator settings, associated with the waveform file, must be saved to the
instrument state memory. If thereisno waveform filein NVWFM, create one using the procedure, “ Creating
Waveform Segments’ on page 108.

You can save sighal generator settings, associated with awaveform file, so that when you load the waveform
from NVWFM and play it, the same signal generator settings can be recalled and re-applied to the waveform
file

Set Up the Signal Generator

Press Preset.

Press Frequency > 2 > GHz.

Press Amplitude > — 30 > dBm.

Press Mode > Dual ARB > Waveform Segments.
Scroll and highlight awaveform filein NVWFM.

o A W N
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6. PressLoad Segment From NVWFM Memory > Return.
7. Scroll to the waveform selected in step 3.

8. Press Select Waveform > ARB Off On to on. This causes the signal generator to play the waveform.

Saving the Instrument State

Instrument states can be saved to any one of the 10 sequences and 100 registersin instrument state memory.
In this procedure, sequence 01 and register 02 are used to store the signal generator settings associated with
the waveform file. The Save function saves instrument settings and the waveform file name but does not
save waveform data. Waveform data can only be saved to NVWFM with the Store function.

1. Press Save > Select Seq > 01 > Select Reg > 02 > Save Reg.

The signal generator settings associated with the waveform file and the name of the waveform file are now
saved in theinstrument state memory. The section “ Recalling an Instrument State for a Waveform File” on
page 73 describes how to recall thisinstrument state and associated waveform file.

Recalling an Instrument State for a Waveform File

This procedure appliesto signal generators with Option 001/601 or 002/602 and demonstrates recalling
signal generator settings associated with a waveform file. This procedure uses the same signal generator
settings and waveform file used in the previous section, “ Saving an Instrument State for a Waveform File”.

1. Press Mode > Dual ARB > Waveform Segments.

2. Scroll and select the waveform file used in the previous section.

3. PressLoad Segment From NVWFM Memory > Return > Select Waveform
4. Highlight thefile selected in step 3.

5. Press Select Waveform.

The next step recalls the signal generator settings associated with the waveform file. These settings were
saved to Seq 01 and Reg 02 in the previous procedure.

6. PressRecall > Select Seq > 01
7. PressRECALL Reg > 01 > Enter.

The signal generator is now setup with the same settings associated with the waveform previously saved to
NVWFM.
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Deleting Registers and Sequences

These procedures describe how to delete registers and sequences saved to an instrument state register.

Deleting a Specific Register within a Sequence

1
2.

Press Preset.

Press the Recall or Save hardkey.

Notice that the Select Seq softkey shows the last sequence that you used.

Press Select Seq and enter the sequence number containing the register you want to delete.

Press Select Reg and enter the register number you want to delete.

Notice that the Delete Seq[n] Reg[nn] should be loaded with the sequence and register you want to delete.
Press Delete Seq[n] Reg[nn].

This deletes the chosen register.

Deleting All Registers within a Sequence

Press Preset.
Press the Recall or Save hardkey.
Notice that the Select Seq softkey shows the last sequence that you used.

3. Press Select Seq and enter the sequence number containing the registers you want to delete.

Press Delete all Regs in Seq[n].

This deletes all registersin the selected sequence.

Deleting All Sequences

CAUTION Be sure you want to delete the contents of all registers and all sequencesin the instrument

state register.

Press Preset.

Press the Recall or Save hardkey.

Notice that the Select Seq softkey shows the last sequence that you used.
Press Delete All Sequences.

This deletes all of the sequences saved in the instrument state register.
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Using Security Functions

CAUTION Do not use the following functions with signal generator firmware revisions C.04.84,
C.04.86, or C.04.95:

* Erase All * Erase and Sanitize All * Erase and Overwrite All

If you have one of the stated revisions installed, please upgrade immediately to firmware
revision C.04.96 or later.

This section describes how to use the ESG security functions to protect and remove classified proprietary
information stored or displayed in the instrument. All security functions described in this section also have
an equivalent SCPI command for remote operation. (Refer to the “ System Subsystem (:SY STem)” chapter
of the E4428C/38C ESG Sgnal Generators SCPI Command Reference for more information.)

Understanding Memory Types

The ESG comprises several memory types, each used for storing a specific type of data. Before removing
sensitive data, it isimportant to understand how each memory typeisused in the signal generator. The
following tables describe each memory type used in the base instrument, optional baseband generator, and
optional hard disk.

Table 3-1 Base Instrument Memory
o &

o5| S

MemorvTvoe | & & | B &
em(?ry ype a2|E § Purpose/Contents Data Input Method | Location in Instrument and Remarks

and Size 29 | &8

=5 (e

EE| =5

= - =

22|82
Main Yes |No firmware operating memory | operating system CPU board, not battery backed.
Memory (not user)
(SDRAM)
64 MB
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Table 3-1 Base Instrument Memory (Continued)
o~ &
o5| S
MemorvTvoe | & & | B S
emx?ry ype as|E 2 Purpose/Contents Data Input Method | Location in Instrument and Remarks
and Size 29|88
SE|%s
= - =
22|82
Main Yes |Yes |factory firmware upgrades | CPU board (same chip as firmware memory,
Memory calibration/configuration data | and user-saved data | but managed separately)
Flash
( ) user file system, which User datais not stored in this memory if hard
20 MB includes instrument status disk (Option 005) isinstalled.
backup, flatness calibration, hi hi )
1Q calibration, instrument Becal;set '332"\3 B mi’:é);]y chip (;ontzal ns 2(1
states, waveforms (including ?_/IB of user data( 0&;; _ ere})fan 12MBo
header and marker data), irmware memory, a selective chip eraseis
modulation definitions, and performed. User data areas are selectively and
sweep li completely sanitized when you perform the
eep lists " )
Erase and Sanitize function.
Firmware No Yes | mainfirmwareimage factory installed or | CPU board (same chip as main flash memory,
Memory firmware upgrade but managed separately)
Flash
( ) During normal operation, this memory cannot
12MB be overwritten except for LAN configuration.
Yes |Yes |[LAN configuration front panel entry or | tiSonly overwritten during the firmware
remotely installation or upgrade process.
Because this 32-MB memory chip contains 20
MB of user dataand 12 MB of firmware
memory (described here), a selective chip
erase is performed. User data areas are
selectively and completely sanitized when you
perform the Erase and Sanitize function.
Battery Yes |Yes |user-editabledata(table firmware operations | CPU board
Backed editors) .
Memory The battery can be removed to sanitize the
(SRAM) last instrument state, last memory, but must be reinstalled for the
instrument state backup, instrument to operate. The battery islocated on
512 kB persistent instrument state the motherboard.
and instrument status
Bootrom No Yes | CPU bootup program and factory programmed | CPU board
Memory firmware loader/updater . . .
(Flash) During normal operation, this memory cannot
be overwritten or erased. Thisread-only datais
128 kB programmed at the factory.
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Table 3-1 Base Instrument Memory (Continued)
o &
o5| S
MemorvTvoe | & & | B S
emx?ry ype as|E 2 Purpose/Contents Data Input Method | Location in Instrument and Remarks
and Size =2° g S
EE|SsS
= 5 - =
=2 |82
Calibration | No Yes | factory factory or service motherboard
Backup calibration/configurationdata | only
Memory backup
Flash
( ) no user data
512KB
Boards No Yes | factory calibration and factory or service all RF boards, baseband generator, and
Memory information files, code only motherboard
(Flash) images, and self-test limits
512 Bytes no user data
Micro- Yes |No CPU data and instruction memory ismanaged | CPU board, not battery backed.
processor cache by CPU, not user
Cache
(SRAM)
3kB
Table 3-2 Baseband Generator Memory (Options 001/601 and 002/602)
~ &
=8 =
M T £8 |3
emqry ype a2 | £ § Purpose/Contents Data Input Method Remarks
and Size 2° g S
SE| G5
= 5 = =
=2 | 8=
Waveform Yes No waveforms (including |normal user operation |User datais completely sanitized when you
Memory header and marker perform the Erase and Sanitize function. Not
(SDRAM) data) and PRAM battery backed.
40-320 MB
BBG No Yes firmware image for firmware upgrade
Firmware baseband generator
Memory
(Flash)
32MB
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Table 3-2 Baseband Generator Memory (Options 001/601 and 002/602) (Continued)
o~ &
=8 S
M - £ |38
em?ry ype a2 | E s Purpose/Contents Data Input Method Remarks
and Size =9 g S
SE|SE
£ E 88
=2 | 8%
Coprocessor | Yes No operating memory of | During hormal This memory is used during normal baseband
Memory baseband coprocessor | operation, someuser | generator operation. It is not directly accessible
(SRAM) CPU information, suchas | by the user. Not battery backed.
payload data, can
32MB remain in the memory.
Buffer No No support buffer memory |normal user operation | This memory is used during normal baseband
Memory for ARB and real time generator operation. It isnot directly accessible
(SRAM) applications by the user. Not battery backed.
5x 512 kB
Table 3-3 Hard Disk Memory (Option 005)
o &
=8 =
Memory Type £ E 3 5
> o s o
and Size ; E=- 'E E Purpose/Contents Data Input Method Remarks
EE |55
== - =
=2 |82
Media Yes Yes user files, including user-saved data The magnetic residue requires several rewrite
Storage flatness calibrations, cycles or drive removal and destruction.
(Built-in 1Q calibration, he hard disk i . distheref
Hard Disk) instrument states, T e narddiscisan optionan 'S.t eretore not
waveforms (including installed in some instruments. If it isinstalled,
6 GB or header and marker Fheﬁefll% are stored on the hard disk instead of
10GB data), modulation in flash memory.
4 GB usable L
( definitions, and sweep User datais completely sanitized when you
in both cases) : )
lists perform the Erase and Sanitize function.
Buffer No No buffer (cache) memory | normal operation
Memory through hard disk
(DRAM)
512 kB

Removing Sensitive Data from Memory

When moving the signal generator from a secure development environment, you can remove any classified
proprietary information stored in the instrument. This section describes several security functions you can
use to remove sensitive data from your instrument.
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Erase All

CAUTION Do not use this function with signal generator firmware revisions C.04.84, C.04.86, or
C.04.95. If you have one of these revisionsinstalled, please upgrade immediately to revision
C.04.96 or later.

This function removes all user files, user flathess calibrations, user 1/Q calibrations, and resets all table
editors with original factory values, ensuring that user data and configurations are not accessible or
viewable. Theinstrument appearsasif itisinitsoriginal factory state, however, the memory is not sanitized.
Thisaction isrelatively quick, taking less than one minute (the exact time depends on the number of files).

To carry out this function, press Utility > Memory Catalog > More (1 of 2) > Security > Erase All > Confirm Erase.

NOTE This function is different than pressing Utility > Memory Catalog > More (1 of 2) >
Delete All Files, which deletes all user files, but does not reset the table editors.

Erase and Overwrite All

CAUTION Do not use this function with signal generator firmware revisions C.04.84, C.04.86, or
C.04.95. If you have one of theserevisionsinstalled, please upgrade immediately to revision
C.04.96 or later.

This function performs the same actions as Erase All and then clears and overwrites the various memory
types in accordance with Department of Defense (DoD) standards, as described bel ow.

SRAM All addressable locations are overwritten with random characters.

CPU Flash All addressable |ocations are overwritten with random characters and then the flash blocks are erased.
This accomplishes the same purpose of achip erase, however, only the areasthat are no longer in use are
erased and the factory calibration files are left intact. System files are restored after erase.

DRAM All addressable locations are overwritten with random characters.

Hard Disk All addressable locations are overwritten with asingle character. (Thisis insufficient for top secret data,
according to DoD standards. For top secret data, the hard drive must be removed and destroyed.)

To carry out this function, press Utility > Memory Catalog > More (1 of 2) > Security > Erase and Overwrite All >
Confirm Overwrite.
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Erase and Sanitize All

CAUTION Do not use this function with signal generator firmware revisions C.04.84, C.04.86, or
C.04.95. If you have one of theserevisionsinstalled, please upgrade immediately to revision
C.04.96 or later.

Thisfunction performsthe same actions as Erase and Overwrite All and then adds more overwriting actions.
After executing this function, you must manually perform some additional steps for the sanitization to
comply with Department of Defense (DoD) standards. These actions and steps are described below.

SRAM All addressable |ocations are overwritten with random characters.

DRAM All addressable locations are overwritten with a single character. You must then power off the
instrument to purge the memory contents.

Hard Disk All addressable locations are overwritten with a single character and then arandom character. (Thisis
insufficient for top secret data, according to DoD standards. For top secret data, the hard drive must be
removed and destroyed.)

To carry out this function, press Utility > Memory Catalog > More (1 of 2) > Security > Erase and Sanitize All >
Confirm Sanitize.

Removing Persistent State Information Not Removed During Erase

Persistent State

The persistent state settings contain instrument setup information that can be toggled within predefined
limits such as display intensity, contrast and the GPIB address. In vector models, the user 1Q Cal isalso
saved in this area.

The following key presses or SCPI commands can be used to clear the |Q cal file and to set the operating
states that are not affected by asignal generator power-on, preset, or * RST command to their factory default:

Instrument Setup

e Onthefront panel, press: Utility > Power On/Preset > Restore System Defaults > Confirm Restore Sys Defaults
e Or send the command: : SYSTem PRESet : PERSI st ent
LAN Setup

The LAN setup (hostname, | P address, subnet mask, and default gateway) information is not defaulted with asignal
generator power-on or *RST command. This information can only be changed or cleared by entering new data.
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User 1Q Cal File (Vector Models Only)

When a user-defined 1Q calibration has been performed, the cal file datais removed by setting the cal file to default, as
follows:

1. Onthefront panel, press: 1/Q > 1/Q Calibration > Revert to Default Cal Settings
2. Send these commands;

e :CAL: I Q DEF

« :CAL:VWBI Q DEF

Using the Secure Mode

The secure mode automatically applies the selected Security Level action the next time the instrument’s
power is cycled.

Setting the Secure Mode Level

CAUTION Do not use the functions Erase, Overwrite, Or Sanitize with signal generator firmware
revisions C.04.84, C.04.86, or C.04.95. If you have one of these revisionsinstalled, please
upgrade immediately to revision C.04.96 or later.

1. Press Utility > Memory Catalog > More (1 of 2) > Security > Security Level.

2. Choose from the following selections:

None — equivalent to afactory preset, no user information is lost
Erase — equivaent to Erase All

Overwrite — equivalent to Erase and Overwrite All

Sanitize — equivalent to Erase and Sanitize All

Activating the Secure Mode

CAUTION Onceyou activate secure mode (by pressing Confirm), you cannot deactivate or decrease the
security level; the erasure actions for that security level execute at the next power cycle.
Once you activate secure mode, you can only increase the security level until you cycle
power. For example, you can change Erase to Overwrite, but not the reverse.

After the power cycle, the security level selection remains the same, but the secure modeis
not activated.

Press Utility > Memory Catalog > More (1 of 2) > Security > Enter Secure Mode > Confirm.
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The Enter Secure Mode softkey changes to Secure Mode Activated.

If Your Instrument is Not Functioning

If the instrument is not functioning and you are unable to use the security functions, you must physically
remove the processor board and optional hard disk, if installed, from the instrument. Once these assemblies
are removed, proceed as follows:

For the processor board, choose one of the following options:

» Discard the processor board and send the instrument to arepair facility. A new processor board will be
installed and the instrument will be repaired and calibrated. If the instrument is still under warranty, you
will not be charged for the new processor board.

» If you have another working instrument, install the processor board into that instrument and erase the
memory. Then reinstall the processor board back into the non-working instrument and send it to arepair
facility for repair and calibration. If you discover that the processor board does not function in the
working instrument, discard the processor board and note that it caused the instrument failure on the
repair order. If the instrument is still under warranty, you will not be charged for the new processor
board.

For the optional hard disk, choose one of the following options:

» Discard the hard disk and send the instrument to arepair facility. Indicate on the repair order that the
hard disk was removed and must be replaced. A new hard disk will be installed and the instrument will
be repaired and calibrated. If the instrument is still under warranty, you will not be charged for the new
hard disk.

» Keep the hard disk and send the instrument to arepair facility. When the instrument is returned, reinstall
the hard disk.

For procedures on removing and replacing the processor board and hard disk, refer to the E4428C/38C ESG
Signal Generators Service Guide.

Using the Secure Display

This function prevents unauthorized personnel from reading the instrument display and tampering with the
current configuration through the front panel. The display is blanked , except for the message*** SECURE
DI SPLAY ACTI VATED *** (see Figure 3-6 on page 83), and the front panel keys are disabled. Once this
function is activated, the power must be cycled to re-enable the display and front panel keys.

To apply this function, press Utility > Display > More (1 of 2) > Activate Secure Display > Confirm Secure Display
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Figure 3-6 ESG Screen with Secure Display Activated
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Enabling Options (E4438C Only)

You can retrofit asignal generator after purchase to add new capabilities. Some new optional features are
implemented in hardware that you must install. Some options are implemented in software but require the
presence of optional hardware in the instrument. This example shows you how to enable software options.

Enabling a Software Option

A license key (provided on the license key certificate) isrequired to enable each software option.

1. Access the Software Options menu:

Utility > Instrument Adjustments > Instrument Options > Software Options
Thefollowing is an example of the signal generator display, which lists any enabled software options,
and the software options that can be enabled:

FREQUERMCY

1.000 000 000 00 &tz

HHPI_IITUDE Hodifu

36.00 dBm License Key
)

Softuare Option Selection Host ID = 7ullbcevs
Option License Key Description
i LOD C=CF CE . 35PP FOD
Lol CLO1127273C8 -+ COMAZO000 AWD ISSSA
L0z CECBL171EFCOD - TOMA SUITE (GSM/EDGE /MOAC/POC/PHS /TETRAOECT )
LO3 CECOL07O7SCA + ALIGM
LOL BFO7L7FF7BCTY « LHEW
LOS COD91&7E81CLY -+ B02. 11B/HYFPERLAN
LOR C103157577C3 + BLUETOOTH Proceed With))
LO7 C2051L7L70CE + 3GFF TOO Reconf igurat ion
LOS BEOF1BTES3C3 « MHMOS
| | u03 BCE11A7ASICO + GPS

2. Verify that the host ID shown on the display matches the host ID on the license key certificate.

The host ID is unique for each instrument. If the host ID on the license key certificate does not match
your instrument, the license key cannot enable the software option.

Verify that any required hardware isinstalled. Software options are linked to specific hardware options,
so before a software option can be enabled, the appropriate hardware option must be installed. For
example, Option 400, W-CDMA, requires Option 001/601 or 002/602, Internal Baseband Generator. If
the software option that you intend to install is listed in agrey font, the required hardware may not be
installed (in the Hardware Options menu, look for an X in the “ Selected” column of the appropriate
hardware option).
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4. Enable the software option:

a. Highlight the desired option.
b. Press Modify License Key, and enter the 12-character license key (from the license key certificate).

c. Verify that you want to reconfigure the signal generator with the new option:
Proceed With Reconfiguration > Confirm Change

The instrument enables the option and reboots.

Using the Web Server

You can communicate with the signal generator using the Web Server. This service uses TCP/IP
(Transmission Control Protocol/Internet Protocol) to communicate with the signal generator over the
internet.

The Web Server uses a client/server model where the client is the web browser on your PC or workstation
and the server isthe signal generator. When you enable the Web Server, you can access aweb page that
resides on the signal generator.

The Web-Enabled ESG web page, shown in Figure 3-7, provides general information on your signal
generator and a means to control the instrument by using aremote front panel interface or using SCPI
(Standard Communication for Programmable Instruments) commands. The web page also has links to
Agilent’s products, support, manuals, and website.

NOTE The Web Server service is compatible with the latest version of the Microsoft© Internet
Explorer web browser.!

The Signal Generator Web Control menu button on the Web-Enabled ESG web page will access a second
web page. This web page, shown in Figure 3-8, provides avirtual instrument interface that can be used to
control the signal generator. You can use the mouse to click on the signal generator’s front panel hardkeys,
softkeys and number pad. Thereis also atext box that can be used to send SCPI commands to the
instrument.

Activating the Web Server
Perform the following steps to access the Web Server.

1. Turnon the Web Server by pressing Utility > GPIB/RS—232 LAN > LAN Services Setup > Web Server On.

1. Microsoft is a registered trademark of Microsoft Corp.
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2. Pressthe Proceed With Reconfiguration softkey.
3. Pressthe Confirm Change (Instrument will Reboot) softkey. The signal generator will reboot.

4. Launch your PC or workstation web browser.
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5. Enter the IP address of the signal generator in the web browser address field. For example,
http://101.101.101.101. Replace 101.101.101.101 with your signal generator’s | P address. Press the
Enter key on the computer’s keyboard.

NOTE The IP (Internet Protocol) address can change depending on your LAN configuration.
Use the LAN Config Manual DHCP softkey to select aManual or DHCP (dynamic host
communication protocol) LAN configuration. Refer to E4428C/38C ESG Sgnal Generator
Key and Data Field Reference for more information.

6. Presstheenter key on the computer’s keyboard. The web browser will display the signal generator’s

homepage as shown below in Figure 3-7. Thisweb page displaysinformation about the signal generator
and provides access to Agilent’s website.

Figure 3-7 Signal Generator Web Page

/% Welcome to Agilent Technologies Web-Enabled Site - Micrasoft Internet Explorer provided by Agilen! : 0 =[O x|

J File Edit View Favorites Toos  Help ﬁ
| Bk - = - 4 | Qisearh Gpavories ¢ Hristory | B S B -
&) e

Fault, htmll

Agilent Technologies ESG Series Signal Generator

P §

£ | T—— Welcome to your

Web-Enabled ESG

signal Generator
wab Control

Information about this Web-Enabled ESG:

rielp with
this Page

E4438C ESO

S 3 UsS41000119

Description: Agilent E4438C (US41000119)
Hostname: GALLP3

IP Address: T4 A21 60173

VISA TCPIP Connect String: TCPIPD:GALLP3INSTR

Firmware Revision: C.04.10.5007

Ethernet (MAC) Address: 00:10:83: 7884 F1
SCPI TCPIP Socket Port: 5025

SCPI Telnet Port: 5023

SICL Interface Name: gpikd

GPIB Address: 19

Use the navigation bar on the leftto access your signal generator and related information

@ Agilent Technalogies, Inc. 2002

| sl

|&] Done || e mermet v
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7. Click the Signal Generator Web Control menu button on the left of the page. A new web page will be
displayed as shown below in Figure 3-8.

Figure 3-8 Web Page Front Panel
Fhttp://141.121.94.9/display - Microsoft Internet Explorer =10l x|
Fle Edt View Favortes Tools  Help |
dmbock - = - @ [2] 4| Qsearch GaFavartes @iveda (B[ EN- 5 B - ]
address | hitp: /101,101,101 101 display =] @oo [uns ”|
E

AMPLITUOE e H Freqg || Mode | MUK AM | Sweep

101.000 000 00O n+= ‘ -130.00 cn O Tl [seup | A | Fu | iy

DIGHOD . r @ Select, 13 | Pulse | LF Out
1/0

‘ éaveFDEm,
Continuous HELP (press ’Help’ Lo exii) Saments

FREQUENCY

Trigg || Help

7
4|5| 6| Save | Recal
1
]

MOD On/Off

Usueform,|
Sequences

RF On/Oft

ARB SetupH

Pressing this key 51l0WS YOU SCCESS to & menu
for operating the Arbitrary waveform oenerator.
Option required.

Freset Local

Trigger,|
(Cont inuous)

%% PROTO CODE *= MNOT FOR CUSTOMER USE === 10/05/2004 03:00
SCPT command [ SEND
&) [ [ |4 nkermer 4

This web page remotely accesses all signal generator functions and operations. Use the mouse pointer to
click on the signal generator’s hardkeys and softkeys. The results of each mouse click selection will be
displayed on the web page. For example, click on the Frequency hardkey then use the front panel key pad to
enter afrequency. You can aso use the up and down arrow keys to increase or decrease the frequency.

You can use the SCPI Command text box at the bottom of the front panel display to send commands to the
signal generator. Enter avalid SCPI command, then click the SEND button. The results of the command will
be displayed on a separate web page titled, “ SCPI Command Processed”. You can continue using this web

page to enter SCPI commands or you can return to the front panel web page.

NOTE It may be necessary to use the web browser Refresh function if the web page does not
update with new settings.
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4 Basic Digital Operation (Option 001/601 or

002/602)

The following list shows the topics covered in this chapter:

“Custom Modulation” on page 91

“Arbitrary (ARB) Waveform File Headers’ on page 93

“Using the Dual ARB Waveform Player” on page 107
“Understanding the 1/Q Modulator Filter” on page 115

“Local Settings for ARB Waveform Formats and the Dual ARB Player” on page 117
“Using Waveform Markers’ on page 124

“Triggering Waveforms’ on page 140

“Using Waveform Clipping” on page 149

“Using Waveform Scaling” on page 157

“Using Customized Burst Shape Curves’ on page 161

“Using Finite Impulse Response (FIR) Filters’ on page 168
“Modifying aFIR Filter Using the FIR Table Editor” on page 173
“Differential Encoding” on page 175

“User-Defined I/Q Maps’ on page 183

“User-Defined FSK Modulation” on page 187

“Creating and Using Bit Files’ on page 190

“Waveform Licensing for Firmware Version 3 C.05.23" on page 195
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» “Using Waveform 5-Pack Licensing (Options 221-229) for Firmware Version < C.05.23” on page 197
*  “Waveform Licenses (Signal Studio “A” Versions)” on page 203
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Custom Modulation

For creating custom modulation, the signal generator offers two modes of operation: the ARB waveform
generator mode and the real time 1/Q baseband mode. The ARB waveform generator mode has built-in
modulation formats such as NADC or GSM and pre-defined modulation types such as BPSK and 16QAM
that can be used to create asignal. The real time 1/Q baseband mode can be used to create custom data
formats using built-in PN sequences or custom-user files along with various modulation types and different
built-in filters such as Gaussian or Nyquist.

Both modes of operation are used to build complex, digitally modulated signals that simulate
communication standards with the flexibility to modify existing digital formats, define or create digitally
modulated signals, and add signal impairments.

Custom ARB Waveform Generator

The signal generator’'s ARB waveform generator mode is designed for out-of-channel test applications. This
mode can be used to generate data formats that simulate random communication traffic and can be used as a
stimulus for component testing. Other capabilities of the ARB waveform generator mode include:

» configuring single or multicarrier signals (up to 100 carriers)
» creating waveform files using the signal generator’s front panel interface

The waveform files, when created as random data, can be used as a stimulus for component testing where
device performance such as adjacent channel power (ACP) can be measured. The AUTOGEN WAVEFCRM
file, that isautomatically created when you turn the ARB waveform generator on, can be renamed and stored
in the signal generator’s non-volatile memory. Thisfile can later be loaded into volatile memory and played
using the dual ARB waveform player.

For more information, refer to the sections “Using the Dual ARB Waveform Player” on page 107 and
“Modes of Operation” on page 24.
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Custom Real Time 1/Q Baseband

Thereal time mode simulates single-channel communication using user-defined modulation types along
with custom FIR filters, and symbol rates. Data can be downloaded from an external source into PRAM
memory or supplied as real time data using an external input. The real time 1/Q baseband mode can also
generate pre-defined data formats such as PN9 or FIX4. A continuous data stream generated in this mode
can be used for receiver bit error analysis. Thismodeis limited to asingle carrier. Thereal time1/Q
baseband mode:

» has more data and modulation types avail able than the ARB waveform generator mode
* supports custom I/Q constellation formats

« has the capability to generate continuous PN sequences for bit error rate testing (BERT)
* needs no waveform build time when signal parameters are changed.

For more information, refer to the custom arb section “Using the Arbitrary Waveform Generator” on page
386, the custom real time section “Using the Real Time I/Q Baseband Generator” on page 392 and the
section on “Digital Modulation” on page 24.
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Arbitrary (ARB) Waveform File Headers

ARB file headers are used to save amodulation format’s signal generator settings and parameters so that the
waveform can be replicated when it is again played back by the dual ARB player. Once amodulation format,
such as Custom real time, has been turned off, the waveform file is available only to the dual ARB player.

File header settings and parameters can be defined and saved aong with the waveform file in the signal
generator’s non-volatile waveform memory (NVWFM). When you load a stored waveform file into volatile
waveform memory (WFM 1), the file header information will be used to configure the ESG so that the dual
ARB player is set up the same way each time that the waveform file is played.

A default file header is automatically created whenever awaveform is generated (turning on a modulation
format), a waveform sequence created, or awaveform file downloaded to the ESG (Refer to the
E4428C/38C ESG Sgnal Generators Programming Guide for details on downloading files).

The following ESG setting and parameter information can be saved to the file header:
* ARB sampleclock rate
* Runtime scaling (only in the dual ARB player)
* Marker 14 settings and routing functions (page 124)
— Polarity
— ALC hold
— RF blanking
» High crest mode (only in the dual ARB player)
* Modulator attenuation
* Modulator filter
» 1/Q output filter (used when routing signals to the rear panel 1/Q outputs)
» Other instrument optimization settings (for files generated by the ESG) that cannot be set by the user.

File headers can also store a user-defined 32-character text description of the waveform or sequencefile. For
details on the file header settings and parameters, refer to “File Header Description” on page 96.

Creating a File Header

When you turn a modulation format on, the ESG automatically generates atemporary waveform file along
with a default marker file and default file header. The temporary waveform file resides in volatile waveform
memory (WFM1) and is named AUTOGEN WAVEFCRM The default file header has no signal generator
settings saved to it and the default marker file consists of all zeros. Refer to the E4428C/38C ESG Sgnal
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Generators Programming Guide for more information on marker files.

When you turn the modulation format off, the AUTOGEN WAVEFCRMfile remainsin volatile waveform
memory (WFM1) and can be selected again for playing only by the dual ARB player. If you turn on another
Arb modulation format or change ESG parameters and settings, the AUTOGEN WAVEFCRMfile will be
overwritten by anew AUTOGEN WAVEFCRM file header, and marker file.

If you want to keep the configuration setup in the AUTOGEN WAVEFCRM(file, saveit, using adifferent name,
to NVWFM. The associated file header and marker file will automatically be saved. For information on
storing files after the modulation format is turned off, see “ Storing Waveform Segments to Non-Volatile
Memory” on page 113.

NOTE Each time an ARB modulation format isturned on, anew AUTOGEN WAVEFCRMal ong with
adefault marker and default file header are generated which overwrites the previous
AUTOCGEN WAVEFCRMfile, marker file and file header.

When the waveform file is stored to non-volatile memory (NVWFM), the associated file header information
isautomatically saved to the signal generator’s/ USER/ HEADER directory and the marker fileis
automatically saved to the signal generator’s / USER/ MARKERS directory. When awaveform file, residing
in WFM1, is selected for playback, the file header settings along with the marker file settings are
automatically applied to the ESG

The following procedure will generate an AUTOGEN WAVEFCORMfile and file header using the ARB
CDMA 2000 modulation format. This procedure for generating an AUTOGEN WAVEFCRMfile and file header
appliesto all the Arb formats.

1. Turnon the ESG and then press Preset.
2. PressMode > CDMA > Arb CDMA2000 > CDMA2000 0ff On to On. See Figure 4-1 bel ow.

The ESG createsthe AUTOGEN WAVEFCRMfile along with adefault file header and default marker file when
the modul ation format, CDMA 2000 in this example, isturned on. At thistime, the file header does not have
signal generator settings or parameters for the currently playing AUTOGEN WAVEFCRM file. You must
modify the default file header settings and parameters for the active modulation and then save the file header
information using the Save Setup To Header softkey.
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Figure 4-1 First-Level Softkey Menu
FREQUENCY AMPLITUDE COMAZ000
aff .
4,000 000 000 00 ez | -136.00 cen ' First-Level Softkey
CDHAZK Nnon Link Menu
10 OH Reverse
| Hulruier“
0 n
CDMA FUD CDMA2000 Setup: SR1 8 Channel
Spreading: SA1 IQ Hod Filter: LO.000MHz
2[][][] Fef Freq: 10.0000000MHz (Int) Spread Rate)l
on Filter: IS-35 Mod W/EQ I/0 Mapping: Mormal (5R1)
Link: Forward PRE Clip |I+jQl: 100.0%
Trig Tupe: Continuous (Free Aun) Retrioger: On
Trig Source: Ext (Patt Trio In 17 Folaritu: Meg
Delau: Off
COMAZ000 Select )
(9 Channel)
( Hore | Not all ARB formats
‘of 2 have a Second Page

Modifying Header Information

This procedure builds on the previous procedure, explaining the different fields of afile header, and showing
how to access, modify, and save changes to the file header information.

In amodulation format, you can access a file header only while the modulation format is active (on). All
ARB modulation formats and the dual ARB player access the file header the same way, except that in some
modul ation formats, the menu may be on page two of the first-level softkey menu.

1. From thefirst-level softkey menu (shown in Figure 4-1), open the Header Utilities menu:
Press More (1 of 2) > ARB Setup > Header Utilities

Figure 4-2 on page 96 shows the default file header for the AUTOGEN WAVEFCRMCDM A 2000 digital
modulation waveform. The Header Fi el d column names the parameters for the file header. The
Saved Header Setti ngs column, shows that the signal generator settings for the active format are
Unspeci f i ed, meaning that no settings have been saved to the file header.

TheCQurrent Inst. Settings column showsthe current signal generator settings for the active
modulation. These settings become the saved header settings when they are saved to the file header (as
demonstrated in Step ).

Chapter 4 95



Basic Digital Operation (Option 001/601 or 002/602)
Arbitrary (ARB) Waveform File Headers

Figure 4-2

CDMAZ2000 Default Header Display
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[ Description Saved Header Settings
. Column
Sample Rate Unspecified 11.0552000 HHz
Marker 1 Polaritu | Unspecified Pos Current Signal Generator
Marker 2 Polarity | Unspecified Pos Settinas
Marker 2 Polarity | Unspecified Pos P U g
Marker L Polarity | Unspecified Fos age Lp
ALC Hold Routing Unspecified Morme
[ | Alt Ampl. Routing | Unspecified kone \
N Paoe Down
N\
[] RF Blank Routing Unspecified Mone \
Page 1
Mod Attenuat ion Unspecified Auto
I/0 Mod Filter Unspecified Auto
I/0 Output Filter | Unspecified Auto
\ — Page 2

\ Default Header Settings

NOTE

If asetting is unspecified in the file header, the signal generator’s current value for that

setting does not change when you select and play the waveform in the future.

2. Savetheinformation inthe Curr ent

Press Save Setup To Header.

Boththe Saved Header Setti ngs column and the Qurrent

I nst.

Set ti ngs column to the file header:

Inst. Settings columnnow

display the same settings; the Saved Header Setti ngs column liststhe settings saved in the file

header.

File Header Description

Thefile header contains the following information:

A description entered for the header, such as a the waveform’s function (saved/edited with

32-Character

Description: the Edit Description softkey, see Figure 4-2). You can use the displayed al pha/symbol
softkeys and the numeric keypad to enter information.

Sample Rate: The ARB sample clock rate.
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Runtime Scaling:

Marker 1...4 Polarity:

ALC Hold Routing:

Alt Ampl. Routing

RF Blank Routing:

High Crest Mode

Mod Attenuation:

1/Q Mod Filter:

1/Q Output Filter:
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The Runtime scaling value. Runtime scaling is applied in rea time while the waveform is
playing. This setting can be changed only for files playing in the dual ARB player.

The marker polarity, positive or negative (described on page 139).

Which marker, if any, implements the ESG’s AL C hold function (described on page 126).
The ALC hold function holds the ALC at its current level when the marker signal islow.
All waveforms generated in the ESG have a marker on the first sample point. In order to
see the results from the three routing selections, you may need to select arange of sample
(marker) points. Setting the marker points is accomplished using the Set Marker on Range
of Points softkey located in the Marker Utilities softkey menu. See “ Setting Marker Points
in aWaveform Segment” on page 132 for more information.

Thiswill display which marker, if any, triggersthe ESG’s alternate amplitude feature when
the marker signal islow. When the marker signal goes high, the trigger is terminated,
disengaging alternate amplitude. You still need to configure the alternate amplitude
parameters located in the Amplitude hardkey menu.

Which marker, if any, implements the ESG’s RF blanking function (described on page
137) when the marker signal islow. RF blanking also uses ALC hold. Thereis no need to
select the ALC Hold Routing for the same marker when you are using the RF Blank
Routing function. When the marker signal goes high, RF blanking is discontinued.

Thisfield displaysthe status of the high crest mode for the dual ARB player. The high crest
mode reduces AL C levels while playing ARB waveform files, resulting in the maximum
output level but reducing power level accuracy. This setting can only be changed for files
in the dual ARB player.

The I/Q modulator attenuation setting.

The I/Q modulator filter setting. The modulator filter affects the 1/Q signal modulated onto
the RF carrier.

The 1/Q output filter setting. The 1/Q output filter is used for 1/Q signals routed to the rear
panel | and Q outputs.

3. Returnto the ARB Setup menu: Press Return.

You are how in the ARB Setup softkey menu. From this menu you can access all the signal generator
settings that are saved to the file header. However, not all ESG settings are saved to the file header. For
example, the ARB Reference Ext Int softkey selection is not part of the saved header settings. Figure 4-3
shows the ARB Setup softkey menu and the softkey paths used in steps four through nine.
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Figure 4-3
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4. Setthe ARB sample clock to 5 MHz: Press ARB Sample Clock > 5 > MHz.

Set the modulator attenuation to 15 dB:

Press More (1 of 2) > Modulator Atten n.nn dB Manual Auto to Manual > 15 > dB.

6. Set the 1/Q modulation filter to athrough:

Press 1/Q Mod Filter Manual Auto to Manual > Through.

7. Set marker one to blank the RF output at the set marker point(s):

Press More (2 of 2) > Marker Utilities > Marker Routing > Pulse/RF Blank > Marker 1.

For information on setting markers, see “Using Waveform Markers’ on page 124.

8. Set the polarity of Marker 1 negative:

Press Return > Marker Polarity > Marker 1 Polarity Neg Pos to Neg.
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Meg IEEEH
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Marker 3 Polar lti
MNeg

Marker L Polarit
Heo IEEEH

Set Markersy

Harker Polar itgnJ

Marker RoutingM

Pulse/RF Blank )
CHone)

ALC Hold)]
(hNone

Alternate

Amelitudeq
(hone)

Harker

Marker

Marker

Marker

Hone

1

)

w

i~
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9. Return to the Header Utilities menu: Press Return > Return > Header Utilities.

Noticethat theQurrent Inst. Settings column now reflectsthe changes made in steps 4 through
8 to the current signal generator setup, but that the saved header values have not changed (as shown in
Figure 4-4 below).

Figure 4-4 Differing Values between Header and Current Setting Columns
FREQUENCY AMPLITUDE Edit,)
4,000 000 000 00 &= | -136.00 cen peseription
COHAZK HOD
170 OH Clear Header
| Save Setup
File Header Information: UFI1:AUTOGEH_AVEFORN Te Header
Header Field Saved Header Settings Current Inst. Settings
[ Description
Sample Fate |11.0592 rHe 5.0000000 MHe  [——— ——— Values Differ between the
Marker 1 Polarity [Positive Neg ] two Columns
Marker 2 Polarity Positive Fos
Marker 2 Polarity  Positive Pos P U
Marker L Polarity  Positive Fos age Lp
ALC Hold Routing Mone Morme
[ | Alt Ampl. Routing  Mone Morme N
\ Paoe Down

FF Blark Routing | Mone Marker 1 |\ \ Page 1

Mod Attenuation AULD 15.00 dB I_\ .
1/0 Mod Filter Aut.o 2.100 FHz k Values Differ between the
I/0 Output Filter — Auto Auto two Columns

- Page 2

10. Save the current settings to the file header: Press the Save Setup To Header softkey.

The settingsfromtheQurrent I nst. Setti ngs column now appear in the Saved Header
Set t i ngs column. Thefile header has been modified and the current instrument settings saved. Thisis
shown in Figure 4-5.
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Figure 4-5

Saved File Header Changes

FREQUENCY

4.000 000 000 00 &tz

COHAZK

ANMPLITUCE

~136.00 am

_ Edit |
Description

Clear Header

Save Setup

File Header Information: UFI1:AUTOGEH_AVEFORN Te Header
Header Field Saved Header Settings Current Inst. Settings
[ Description
Sample Rate 5.0000 HHz 5.0000000 MHz
Marker 1 Polarity  Meoatiwve Meg
Marker 2 Polarity  Positive Pos
Marker 2 Polarity  Positive Pos P U
Marker L Polarity  Positive Fos age Lp
ALC Hold Routing Mone Morme
[ | Alt Ampl. Routing  Mone Morme
Fage Doun
RF Blank Routing Marker 1 Marker 1 \ Pagel
Mod Attenuation 15.000 de 15.00 de
I/0 Mod Filter 2.1000 MHz 2.100 HHz
I/0 Output Filter  Auto Auto

—— Page?

While amodulation format is active (on), the AUTOGEN WAVEFCRMwaveform file plays and you can
modify the header information. Once you turn the modulation format off, the header information is available
only through the dual ARB player.

NOTE If you turn the modulation format off and then on, you overwrite the previous

AUTCGEN WAVEFCRM file and its file header. To avoid this, rename the file before you turn
the modulation format back on (see “ Storing Waveform Segments to Non-Volatile

Memory” on page 113).
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Dual ARB Player Waveform Sequence File Headers

When you create a waveform segquence (described on page 109), the ESG automatically creates a default
file header, which takes priority over the headers for the waveform segments that compose the waveform
sequence. During a waveform sequence playback, the waveform segment headers are ignored (except to
verify that all required options are installed). When you store the waveform sequence, itsfile header is
stored with it.

Follow the procedure “ Creating a Waveform Sequence” on page 109 to generate a waveform sequence file
header.

Editing and Viewing File Headers in the Dual ARB Player

Before you can edit afile header in the dual ARB player, the associated waveform file must residein volatile
waveform memory (WFM1). In addition, you cannot edit the AUTOGEN WAVEFCRM(file header in the dual
ARB player if the AUTOGEN_WAVEFCORM fileis currently being played by another modulation format such
as Custom real time. Turn off the modulation format then play the AUTOGEN WAVEFCRM file using the dual
ARB player. You can then modify the file header.

If you want to edit afile header for awaveform file that resides in non-volatile memory (NVWFM), moveit
to WFM1 and then play it. Refer to “Loading Waveform Segments from Non-Volatile Memory” on page 114
for information on loading files from NVWFM.

Edits to file headers can only be performed when the waveform file is playing. After making changesto the
signal generator settings and parameters, you can apply these new settings to the waveform by pressing the
Save Setup To Header softkey and then reselecting the waveform file for playback. When you do this, you will
seethevaluesfrom the Saved Header Setti ngs column overwritethe settingsintheCurrent | nst.
Set ti ngs column. For information on selecting and playing waveform files, see “ Playing a Waveform
Sequence” on page 110.

NOTE Editsto file headers can only be performed when the waveform fileis playing.

Modifying File Header Information

All file header descriptions listed in the procedure “ Modifying Header Information” on page 95 arevalidin
the dual ARB player. The following procedure selects awaveform file, accessesits file header, and then
refers you back to the aforementioned procedure to perform the edits. This procedure assumesthereisan a
user-defined waveform file or an AUTOGEN WAVEFCRM file in WFM 1. For information on creating the
AUTOGEN WAVEFCORM file and associated file header, refer to “Creating a File Header” on page 93.

1. Press Mode > Dual ARB > Select Waveform.
2. Using the arrow keys, highlight the waveform file that needs its file header edited.
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Press the Select Waveform softkey.
Press ARB 0ff On to On.

Press ARB Setup > Header Utilities.
Edit the file header.

o o A~ w

a. If you have a default file header, go to “Modifying Header Information” on page 95, read the
additional information for step one, and then perform the rest of the steps in the procedure.

b. If you need to edit an existing file header, start with step three in the “Modifying Header
Information” procedure on page 95.
Viewing the file header with the Dual ARB Player Off

One of the differences between the dual ARB player and other Arb formatsisthat you can view afile header
without the dual ARB being on (ARB Off On softkey set to Off). However, you cannot edit the displayed file
header. Thiswas done to prevent an accidental change to afile header for an AUTOGEN WAVEFCORM file that
may be playing in amodulation format. With the dual ARB player turned off, perform the following steps.

1. PressMode > Dual ARB > Select Waveform.

2. Using the arrow keys, highlight the desired waveform file.
3. Pressthe Select Waveform softkey.

4. Press ARB Setup > Header Utilities.

Thefile header is displayed in the ESG display and you can see that the file header editing softkeys are
grayed-out (inactive) as shown in Figure 4-6 on page 103.
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Viewing a File Header

FRECLENCY

4.000 000 000 00 &+

AMPLITUOE

136.00 den
B

Header Field

File Header Information: WFA1:DOC_MFN_021105

Saved Header Settings

Current Inst. Settings

Header Editing Softkeys

T~ Grayed-Out

file header and Current

Signal Generator Settings

Viewing a Different File Header

View
Description DiFﬁgggg:&'
Sample Rate 5.0000 MHz 5. 0000000 MHz
Funtime Scaling S2.00 X 52.00 X
Marker 1 Polaritu Positive Fos
Marker 2 Polarity Positive Fos
Marker 3 Polarity  Positive Fos
Marker 4 Polaritu Positive Pos Page Up
ALC Hold Routing Mone Mone
Alt Ampl. Routing  MNone Mone N
Fage Down
FF Blank Routing Marker 1 Harker 1
High Crest Mode — OFF nfF Page 1
Mod Attenuation Auto Auto
I/0 Mod Filter Auto Auto
I/0 Output Filter Auto Auto
—] Page 2

You can view file headers for other waveform files, even while the dual ARB player has awaveform
playing. However, you can edit afile header only when the associated waveform fileis being played by the
dual ARB player. When you select another file header for viewing, the header editing softkeys are
grayed-out as shown in Figure 4-6.

This procedure will guide you through the available viewing choices.

1. Press Mode > Dual ARB > ARB Setup > Header Utilities > View Different Header

Notice that the waveform filesin the table are listed in alphabetical order.
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Figure 4-7 Waveform File List for Viewing a Different Header

FREQUENCY ANFLITUDE View

4.000 000 000 00 &=z | -136.00 cen Heager

’7 oo Catalos T 4 Current Waveform File
| Type
/7 N\
(_ratalog of WFM Files }— 5052335 butes used 128337376 butes fres /
File Hane ﬁiih Size Modif

AU TOGER LIAYEFOFM
BT
DOC_LFM_021105
G1_BLCH_COMA
G2_SCH_COMA
53_SCH_COMA
RAMP_TEST_HFM
SINE_TEST_HFM
TST_HKR_2

LIFM1 2
=y
06/08/98 00:00
B55360  0B/02/38 00:00 <—
B55360  0B/02/38 00:00
B55360  0k/02/38 00:00

200 0OE/08/92 00:00

200 0E/08/92 00:00
B55360  Ok/08/38 D0:00

Table

F=R--I NN N L LN

2. Pressthe Catalog Type softkey.

Now you have a choice of three waveform file types that can be displayed in the table accessed in step
one. These choices are shown in Figure 4-8.

Figure 4-8 Waveform File Type Selection

FREQUENCY

4.000 000 000 00 &tz

ANMPLITUCE

136.00 Hesder
’7 ﬂ Catalog Tupe’
OH CLFHLY

Catalog of WFNL Files 5032336 butes used 128997376 butes fres HWHFT!
File Hame Tupe Size Nodified
1 AUTOGEM LAWEFORM  LIFM1 N
2 BT MFML 50000 06/08/98 00:00 5eq
3 DOC_WFH_O021105  WFHL 1179648  06/08/98 00:00
L G1_BLCH_COMA  WFHL BEE3E0  0&/08/98 00:00
L G2_SCH_COMA  WFHL BEE3E0  0&/08/98 00:00 HUFH1
i1 G3_SCH_COMA  HFHL BEE3E0  0B/08/98 00:00
7 RAMP_TEST_HFH  LFM1 800 0O&/08/98 00:00
8 SINE_TEST_HFH  LIFM1 800 0O&/08/98 00:00
a TST_MER_Z  LIFM1 BEE3E0  OR/08/98 00:00

NVWFM This choice will display al of the waveform segments currently stored in
non-volatile memory.

Seq This choice will display al of the waveform sequence files.
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WFM1 This choice will display al of the waveform segments that currently residein
volatile memory.

3. Pressthe NVWFM softkey.

After pressing the softkey, you are returned to the waveform file listing table that now displays the
waveform files from non-volatile memory. Thisis shown in Figure 4-9.

Figure 4-9 NVWFM Waveform Files Showing
FREQUENCY AMPLITUE View
4.000 000 000 00 &= | ~136.00 a»

oo Cataloa-tuee — Current Waveform File
| Type
V- N\

(catalog of HUUFTI Files) T2536 butgs ysed ELIEIE3ERE butes free

File Hame / Tupe Size Nodifj

1 AL TGE N LFUEF O
2 gT 71470 DB:01
3 DOC_WFM_021105 9FC0  01/22/70 08:04
y 51_ELCH_COMA BSE360 01/16/70 09:40 | <f—— Table
5 52_8CH_COrA BE5360 01,/09/70 09:27
6 53_8CH_COrA BSS360 01/21/70 10:43
7 RAMP_TEST_LFM 800 01/10/70 07:58
8 STME_TEST_LFM 800 01/09/70 09:27
] TST_HRR_2 BES3E0  O1/16/70 10:L3

4. Highlight awaveform file.
5. Pressthe View Header softkey.

Thefile header for the selected waveform fileis shown in the ESG display. If there was awaveform playing,
its header information is removed from the ESG display, but its settings are still used by the signal generator.
There are two ways to return to the header information for the playing waveform. One way is to pressthe
View Different Header, select the current playing waveform file, and press View Header. The second way isto
press Return and then Header Utilities.

Playing a Waveform File containing a Header

After awaveform file (AUTOGEN WAVEFCRM) has been generated by amodulation format and the format is
turned off, the AUTOGEN_WAVEFCRM file is accessible to and can be played back only in the dual ARB
player. Thisis also true for downloaded waveform files.

Thefile header settings, associated with the waveform file, are used to configure signal generator settings
and parameters when the waveform is selected for playback in the dual ARB. Some of these settings will
appear as part of the softkey labels. In addition, some of the saved header settings will appear on the dual
ARB summary display. Thisis shown in Figure 4-10 on page 106. Follow the procedure “Playing a
Waveform Sequence”’ on page 110 to apply file header settings and to play back a waveform.
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Figure 4-10 File Header Settings Applied
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If you change any of the signal generator settings listed in the file header after the waveform file is selected,
the changed setting(s) will appear inthefileheader’'sQurrent I nst. Settings columnand they will be
applied to the signal generator instead of the saved header settings. To reapply the saved header settings,

reselect the waveform for playback.

NOTE
as are required to generate thefile.

The signal generator used to play back a stored waveform file must have the same options
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Using the Dual ARB Waveform Player

The dual arbitrary (ARB) waveform player is used to play back waveform files. There are two types of
waveform files: segments and sequences. A segment is awaveform file that is created using one of the
signal generator’s pre-defined ARB formats (Custom, W-CDMA, CDMA 2000, etc.). A sequence can be
described as several segments strung together to create one waveform file. Waveform files can also be
created remotely using another signal generator or using computer programs and downloaded to the ESG for
playback by the dual ARB waveform player. For information on downloading waveforms, refer to the
E4428C/38C ESG Sgnal Generator Programming Guide. The dual ARB player is used to rename and store
waveform files and to load waveform files from the signal generator’s memory.

A waveform file is automatically generated whenever an ARB modulation format isturned on. This
automatically generated file is named AUTOGEN WAVEFCRM Because this default file nameis shared among
al ARB formats, it must be renamed if you want to save the information contained in thefile. If thefileis
not renamed, it will be overwritten when another ARB format is turned on.

Before you can play or edit any waveform file, it must reside in volatile waveform memory. The signal
generator has two types of memory, WFM1 (volatile waveform memory) and NVWFM (non-volatile
waveform memory). Load a stored waveform file from NVWFM into volatile memory (WFM1) where it
can be edited or played by the ARB waveform player.

The dual ARB waveform player provides markers (page 124), triggering (page 140), and clipping (page
149) capabilities.
Accessing the Dual ARB Player

Press Mode > Dual ARB.

Thefirst-level softkey menu is shown in the following figure. Most procedures start from this menu.

FREQUENCY AMPLITUDE ARE
4.000 000 000 00 &=z { -136.00 aen o b
noo Select,
OH Haveform
| EaueFD{m'
eaments
ARB Selected laveform: #HOHE3#
Sample Clock: 100.0000000MHz I0 Mod Filter: Throush
Uff Fef Freq: 10.0000000MHz <Int) Haveform,
Sequences
Trig Tupe: Continuous (Free Run) Retrigoer: On
Trig Source: Ext (Patt Trig In 1) Polaritu: HNeg
Delau: Off ARE Setupk
FPouer Search Reference: Fixed
Moize: Off Carrier to Moise: 0.00dB
Carrier Bandwidth: 1.000Hz Trigoer
RF Flat Moise Bandwidth > 80.000HHz (Continbons )

Chapter 4 107



Basic Digital Operation (Option 001/601 or 002/602)
Using the Dual ARB Waveform Player

Creating Waveform Segments

There are two ways to provide waveform segments for use by the waveform sequencer. You can either
download a waveform viathe remote interface, or generate a waveform using one of the Arb modulation
formats. For information on downloading waveforms via the remote interface, see the E4428C/38C ESG
Sgnal Generator Programming Guide.

The following procedure describes how to create waveform segments using |S-95A CDMA waveforms. In
this procedure, you generate two 1S-95A CDMA waveforms, a predefined 64 channel forward CDMA state
and apredefined 9 channel forward CDMA state. After the two waveform segments are named and stored in
memory, they are used to build awaveform sequence in the procedure, “ Creating a Waveform Sequence” on
page 109.

1. Generate the first waveform:

oooTo

Press Preset .

Press Mode > CDMA > Arb 1S-95A.

Press Setup Select > 64 Ch Fwd.

Press CDMA 0ff On until On is highlighted.

This generates a waveform named AUTOGEN WAVEFCRMwith the predefined 64 channel forward
link CDMA configuration. The 64 channel forward link AUTOGEN WAVEFCRMis stored in volatile
waveform memory (WFM1). During waveform generation, the CDMA and I/Q annunciators are
shown on the ESG’s front panel display.

Press CDMA 0ff On until Off is highlighted.

The AUTOGEN WAVEFCRMfile isin use while the ARB modulation format is on; preventing you
from performing the modifications to the file as required in the following steps. When the
modulation format is turned off the AUTOGEN WAVEFCRMfile remainsin WFM 1 and can be
modified and saved using a different file name.

2. Createthe first waveform segment.

The AUTOGEN WAVEFCRM created in the previous step, will be renamed and become the first waveform
segment.

opoTp

Press Mode > Dual ARB > Waveform Segments > Load Store t0 Store.

Highlight the default AUTOGEN WAVEFORM(file using the front panel arrow keys.

Press Rename Segment > Editing Keys > Clear Text.

Enter afile name (for example, FWDCH_64), and press Enter > Store Segment To NVWFM Memory.
This renames the waveform segment, and stores a copy in non-volatile memory (NVWFM).

NOTE

Because there can be only one AUTOGEN WAVEFCRM waveform in WFM1 at any given
time, you must rename thisfile to clear the way for a second waveform.
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3. Generate the second waveform:

a. Press Mode > CDMA > Arb IS-95A.

b. Press Setup Select > 9 Ch Fwd.

c. Press CDMA off On until On is highlighted.
d. Press CDMA 0ff On until Off is highlighted.

4. Create the second waveform segment:

Repeat Step 2, giving this segment a different descriptive name (for example, FWDCH_9).

Creating a Waveform Sequence

A waveform sequence is made up of segments but can also contain other sequences. Any number of
segments, up to 32768, can be used to create a sequence. This limit count is determined by the number of
segments in the waveform segquence. Segments and sequences can be repeated within a waveform sequence
and the total of al segments and repeated segments cannot exceed the limit count. Figure 4-11shows a
waveform sequence made up of two sequences and three segments. In this example the segment count is
eleven.

Figure 4-11 Waveform Sequence Diagram

Sequence B
Fepeated 4x

Sedqment @
Sequence B____]:: Seqment T
Seqment M

The following procedure shows how to cregate, edit, and store awaveform sequence using the two waveform
segments created in the section “ Creating Waveform Segments’ on page 108. This procedure assumes that
the waveform segments FADCH 64 and FWDCH_9 are present in WFM 1. To use a segment in asequence, the
segment must reside in volatile memory; for information on loading waveform segments from non-volatile
to volatile memory, see page 114.

Sequence A

Wave form
Sequence

Building a Waveform Sequence

1. Select the waveform segments:

Define a sequence as one repetition of the FWDCH 64 segment followed by one repetition of the
FWDCH_9 waveform segment.
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a  Press Mode > Dual ARB > Waveform Sequences > Build New Waveform Sequence > Insert Waveform.

b. Highlight the FPADCH_64 waveform segment and press Insert Selected Waveform.

o

Highlight the FWDCH_9 waveform segment and press Insert Selected Waveform.
d. Press Done Inserting
2. Optional: Enable markers as desired for the segments in the new sequence: see page 134.

3. Name and store the waveform sequence to the Cat al og of Seq Fi | es inthe memory catalog:

a.  Press Name and Store.
b. Enter afile name (for example, FADCH_64+FWDCH_9).

Cc. PressEnter.

Playing a Waveform Sequence

You can play awaveform sequence or a waveform segment using this procedure. Both waveform types use
the same process.

If you have not created waveform segments and used them to build and store a waveform sequence,
compl ete the stepsin the previous procedures, “ Creating Waveform Segments’ on page 108 and “Creating a
Waveform Sequence’ on page 109.

NOTE A waveform segment must reside in volatile memory (WFM1) before it can be played
individually or as part of awaveform sequence. Refer to “Loading Waveform Segments
from Non-Volatile Memory” on page 114 for more information.

1. Select awaveform sequence:

a  Press Mode > Dual ARB > Select Waveform.

b. Highlight awaveform sequence (for this example, FWDCH_64+FWDCH_9) from the Sequence
column of the Sel ect Wavef or mcatalog, and press Select Waveform.

The display shows the currently selected waveform (for example, Sel ect ed Wavef orm
SEQ PWDCH_64+FWDCH 9).

2. Generate the waveform:
Press ARB 0ff On to On.

This plays the waveform sequence created in the previous procedures. During the waveform sequence
generation, the ARB and | / Qannunciator are displayed. The waveform is now modulating the RF carrier.
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3. Configure the RF Output:

a. Setthe RF carrier frequency.
b. Set the RF output amplitude.
c. Turnon the RF output.

The waveform sequence is now available at the signal generator’s RF OUTPUT connector.

Editing a Waveform Sequence

This procedure shows how to edit waveform segments within a waveform sequence, and then save the
edited sequence with the segment changes. Within the editing display, you can change the number of times
each segment plays (repetitions), delete segments from a sequence, add segments to a sequence, toggle
markers on and off (described on page 134), and save changes. There are two ways to save changes, they
can be saved to the current waveform sequence or they can be saved using a different waveform sequence
name.

NOTE If you do not store changes to the waveform sequence before exiting the waveform
sequence editing display, changes will not be made.

Modifying the Sequence

1. Press Waveform Sequences.

2. Highlight the waveform sequence (for example, FADCH_64+FWDCH 9.
3. PressEdit Selected Waveform Sequence.

4. Highlight the first waveform entry (for example, WWML: FWDCH_64).

5. PressEdit Repetitions > 100 > Enter.

The number of repetitions for the first waveform entry changes to 100 and the cursor moves to the next
entry.

6. PressEdit Repetitions > 200 > Enter.

You have now changed the number of repetitions for each waveform segment entry from 1 to 100 and 200,
respectively. The following procedures show how to save these changes.

Saving Changes to the Current Sequence Name

Press Name and Store > Enter

You have now changed the number of repetitions for each waveform segment entry from 1 to 100 and 200,
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respectively. The sequence with the changesis stored under the same nameto the Cat al og of Seq
Fi | es inthesigna generator’s memory catalog.

Saving Changes to a Different Sequence Name

1. Press Name and Store.
2. PressEditing Keys > Clear Text.

3. Enter afile name (for example, CH64_100+CH9 200) using the dpha/symbol softkeys and the numeric
keypad.

4. PressEnter.

A new waveform sequence, CH64_100+CH9_200 is now defined based on the original sequence. It isa
copy of the original sequence, FADCH _64+FWDCH 9.

Adding Real Time Noise to a Dual ARB Waveform (Option 403)

The signal generator with option 403 can apply additive white gaussian noise (AWGN) to acarrier in real
time while the modulating waveform fileis being played by the dual ARB waveform player. The AWGN
can be configured using front panel softkeys. The Carrier to Noise Ratio softkey allows you to specify the
amount of noise power relative to carrier power that is applied to the signal. The Carrier Bandwidth softkey
sets the bandwidth over which the noise isintegrated and the Noise Bandwidth Factor softkey allows you to
select aflat noise bandwidth. Refer to the E4428C/38C ESG SCPI Command Reference for remote operation
commands and the E4428C/38C ESG Signal Generator Key and Data Field Reference for key descriptions.

The following procedure sets up a carrier and modulates it using the pre-defined SI NE_TEST_WFM
waveform file. AWGN is then applied to the carrier.

Configuring AWGN

Preset the signal generator. Press the Preset hardkey.

Press the Frequency hardkey and enter 1.5 GHz.

Press the Amplitude hardkey and enter —10 dBm.

Press RF On Off to On.

Press Mode > Dual ARB > Select Waveform and highlight the SI NE_ TEST W-Mwaveform.
Press Select Waveform.

Press ARB 0ff On to On.

Press ARB Setup > ARB Sample Clock enter 50 MHz.

Press Real-time Noise Setup > Carrier to Noise Ratio and enter 30 dB.
10 Press Carrier Bandwidth and enter 40 MHz.

11. Press Real-time Noise 0ff On to On.

CoNoU~WDNE

This procedure applies AWGN to the 1.5 GHz carrier. The displayed power level of the signal generator,
—10 dBm, will include the noise power which is set as acarrier to noiseratio (C/N) of 30 dB. Noise power,
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for the purpose of C/N, isapplied across a carrier bandwidth of 40 MHz. The default noise bandwidth factor
is 1, which provides aflat noise signal bandwidth of aleast 0.8 times the 50 MHz sample rate.

Storing and Loading Waveform Segments

Waveform segments can reside in volatile memory (WFM1), or they can be stored in non-volatile memory
(NVWFM), or both. However, to play or edit awaveform file, the file must reside in WFM 1. Because files
stored in volatile memory do not survive a power cycle, it isagood practice to store waveform files to
non-volatile memory and load them to volatile memory whenever you want to use them.

Storing Waveform Segments to Non-Volatile Memory

Recall that there are two types of files used in the dual ARB player, segments (a single waveform file) and
sequences (a series of waveform files). A sequence is comprised of multiple segments and may include other
sequences. Refer to “ Creating a Waveform Sequence” on page 109 for more information on segments and
sequences.

The segments that compose awaveform sequence are not stored when the waveform sequence is stored. You
must save any segment or segments used to create a waveform sequence. Storing just the waveform
sequence will result in losing the waveform segments when the signal generator isturned off or rebooted
during an ESG firmware upgrade. When this occurs, you cannot play the waveform sequence until the
segments are recreated using the same file names that the sequence expects. If you attempt to play the
sequence without the segments, an error, ERROR: 629, File format invalid will be reported, since the dual
ARB player can no longer find the waveform segments that make up the sequence.

Waveform segments must reside in volatile memory (WFM1) to be edited or played individually and all
components, such as segments and other sequences, of a sequence must residein WFM 1.

The following example demonstrates storing waveform segments. If you have not created waveform
segments, complete the steps in the previous section, “ Creating Waveform Segments’ on page 108. In this
example, the sequenceis stored to the Cat al og of Seq Fi | es and the segments are stored to the

Cat al og of NWWFMfiles.

1. Press Mode > Dual ARB > Waveform Segments.

2. PressLoad Store to Store.

3. Highlight the waveform segment you want to store.

4. |If the waveform segment needs to be renamed, follow steps athrough d, if not, proceed to step five.
a. PressRename Segment > Editing Keys > Clear Text.

b. Enter aname for the waveform segment using the displayed alpha/symbol softkeys along with the
numeric keypad. The maximum length for afile nameis 23 characters (alphanumeric and specia
characters).
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C. PressEnter.

d. Highlight the waveform segment that was renamed.
5. Press Store Segment to NVWFM Memory.
6. Repeat stepsthree through five for all segments that you want to store.
In addition to the above method for saving segmentsto NVWFM, the signal generator alowsyou to store all
files, residing in WFM1, into NVWFM. Thisis accomplished using the Store All to NVWFM Memory softkey.
Loading Waveform Segments from Non-Volatile Memory

Waveform segments must reside in volatile memory (WFM 1) before they can be played, edited, or be
included in a sequence. In addition, you need to load segments into WFM 1 whenever power is cycled to the
ESG or an action initiated that causes the ESG to reboot.

1. Press Mode > Dual ARB > Waveform Segments.
2. Highlight the waveform segment you want to load.
3. PressLoad Segment From NVWFM Memory.

In addition to the above method, the signal generator allows you to load al files, residing in NVWFM, into
WFM1. Thisis accomplished using the Load All From NVWFM Memory softkey.
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Understanding the 1/Q Modulator Filter

The 1/Q modulator filter (1/a Mod Filter Manual Auto SOftkey) lets you select either post-reconstruction low pass
filtering that has a narrower bandwidth than that of the reconstruction filter, or no post-reconstruction
filtering. It can be used with both real time and ARB signals.

There are two modes for the 1/Q modulator filter: auto or manual. With auto, the signal generator
automatically selects either filtering (2.1 MHz or 40 MH2z) or no filtering depending on the signal
configuration. With manual, the user can select a2.1 MHz filter, a40 MHz filter, or no filter.

Thelow passfilter selections are fifth order elliptic filters that exhibit very low passband ripple. Thesefilters
are positioned before the 1/Q modulator, so thefiltering is applied separately to the | and Q paths. Since they
are post-reconstruction filters, they do not apply any oversampling.

Because the filters are for the | and Q signals and not the modulated signal, they are filtering the I/Q
bandwidth, which has up to 40 MHz for | and 40 MHz for Q (80 MHz total 1/Q bandwidth). This meansthat
when viewed through the RF output, the filter size appears to be twice the size of the selected filter. For
example, the 2.1 MHz 1/Q bandwidth filter shows as a 4.2 MHz filter in the RF bandwidth.

Through Filter 2.1 MHz Filter
Atten 18 dB dBi Atten 18 dB

Rl RF Bandwidth
[l larger than 4 MHz

#VBH 100 Hz

The 2.1 MHz filter is for improving the ACPR on single carrier wideband signals such as W-CDMA.. The
40 MHz filter is best used to eliminate spurious events. Aswith any filter, the 1/Q modulator filters do add
some group delay. To determine whether the filters may be contributing to distortion or some unexpected
signal artifact, select the through path and view the signal. If thereis no change in the signal, then the I/Q
modulator filter is not the cause.
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Applying An 1/Q Modulator Filter

Real Time Signals

1. Configurethe signal.
2. Set the I/Q modulator filter:
a Pressl/Q > More (1 of 2) > 1/Q Mod Filter Manual Auto.

Thiskey is active only when using area time signal. When using an ARB signal, the /0 Mod Filter
Manual Auto softkey within the 1/Q menu grays out.

b. Inthefilter menu, select Through, 2.1 MHz, 40 MHz, or Auto.
3. If not already done, turn on the modulation format.
4. Turn onthe RF output.

ARB Signal

The 1/Q modulator filter selections reside within the modulation format menu, instead of in the 1/Q menu as
for the real time signals. For more information, see “1/Q Attenuator and Filters Settings’ on page 117.

1. Configurethesignal.
2. Within the ARB modulation format menu, set the 1/Q modulator filter:
a. Press ARB Setup > more (1 of 2) > 1/Q Mod Filter Manual Auto.
The more (1 of 2) softkey may not appear in all menus.
b. Inthefilter menu, select Through, 2.1 MHz, 40 MHz, or Auto.
3. If not already done, turn on the modulation format.
4. Turn onthe RF output.
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Local Settings for ARB Waveform Formats and the Dual ARB Player

To provide you with the greatest convenience in optimizing and replicating waveforms for playback in the
dual ARB player, settings that were previously (pre-C.03.10 firmware release) found in only the dual ARB
player have now been incorporated into each of the ARB modulation formats. In addition, some of the I/Q
waveform settings previously found in the 1/Q and MUX hardkey menus are also present in the ARB
modulation formats and the dual ARB player. These settings are shown in the following list, and explained
in the sections that follow:

* 1/Q output filter

* 1/Q modulator filter

* 1/Q modulator attenuator

*  Waveform runtime scaling
» High crest mode

* ARB sample clock

*  Markers

1/Q Attenuator and Filters Settings

The 1/Q output filter, modulator attenuator, and the 1/Q modulator filter parameters are now set locally
within each ARB modulation format (W-CDMA, CDMA 2000, AWGN, Multitone, etc.) and the dual ARB
player. When you set these signal generator parameters within one modulation format, they will not apply to
the others. These settings are applied to the signal generator when the modulation format is turned on or the
saved waveform is selected in the dual ARB player. They can also be saved to the file header. The I/Q output
attenuator (1/Q Output Atten softkey located in the I/Q hardkey menu) still maintainsits original behavior in
that it isaglobal setting (appliesto all signal generator formats).

Front Panel Changes

In pre-C.03.10 firmware releases, the I/Q output filter, modulator attenuator, and the 1/Q modulator filter
parameters were set globally from the 1/@ and/or the Mux hardkey menus using the 1/Q Mod Filter Manual
Auto, Modulator Atten nnn dB Manual Auto, 1/Q Output Filter Manual Auto, and the I/Q Mod Filter Manual Auto
softkeys. These three softkeys now appear in each of the ARB formats and the dual ARB player. This
enables you to set these parameterslocally within each ARB format and the dual ARB player.

The three softkeys in the I/Q and mux menus now apply only to the real time formats and externally applied
I/Q signals. Thereal time formats are the ones preceded with real time on the ESG softkey labels and usually
have BBG as one of the SCPI command mnemonics. When an ARB format or the dual ARB player isactive,
the three softkeys in the I/Q and mux menus are grayed-out indicating that they do not apply to the ARB
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format or

the dual ARB player.

Setting the three parameters, for the ARB formats or the dual ARB player, are accomplished by accessing
the ARB Setup softkey menu located in each of the ARB formats and the dual ARB player. The location of
this softkey menu is shown in Figure 4-12.

When you save the signal generator setup using the front panel Save hardkey function with an ARB format
or the dual ARB player, the local settings for the three parameters are also saved.

Figure 4-12 ARB 1/0Q Filters and Attenuator Softkey Location
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SCPI Command Changes

New SCPI commands have been developed and included in the C.03.10 and later versions of the firmware.
These new commands allow you to set the three parameters discussed earlier for each of the ARB

modul ation formats and the dual ARB player. Commands have also been changed for the three parametersin
the Digital Modulation subsystem to accommodate the local setting feature.

These new commands duplicate the behavior of the softkeys discussed in the previous section. The main
differenceisthat now you can set new values for the three parameters (available in the 1/Q and/or MUX
menus) while an ARB modulation format is active and playing. However, the new settings will not be
applied until the ARB format is turned off. Then they are used only if areal time modulation format is
turned on or an external 1/Q signal is applied to the ESG.

The pre-C.03.10 Digital Modulation subsystem filter and attenuator commands will still work and have the
same behavior, in that they apply changes globally. This means that if you configure alocal setting for an
ARB format using the new commands, and then executed the older commands from the Digital Modulation
subsystem, the older commands would override the local settings.

Waveform Runtime Scaling

Waveform runtime scaling enables you to set the scaling value that is applied to the waveform whileit is
playing.

You can set waveform runtime scaling in the ARB Setup softkey menu located in the dual ARB player. The
location of this softkey is shown in Figure 4-12. This setting is only available for the dual ARB player.

When you save the signal generator setup using the front panel Save hardkey function with the dual ARB
player, the local setting for waveform runtime scaling is also saved.

High Crest Mode

High crest mode reduces AL C levels while processing ARB waveform files, resulting in signals with less
distortion and improved EVM. However, in the high crest mode, the maximum output level is reduced and
power level accuracy is degraded.

You can set this parameter by in the ARB Setup softkey menu located in the dual ARB player. The location of
this softkey is shown in Figure 4-12. This setting is only available in the dual ARB player.

When you save the signal generator setup using the front panel Save hardkey function with the dual ARB
player, the local setting for high crest mode is aso saved.

ARB Sample Clock

Each ARB modulation format and the dual ARB player incorporate alocal ARB sample clock parameter.
For example, you can set the ARB CDMA 2000 modulation format’'s ARB samplerate to 5 MHz, and this
parameter would apply only to the ARB CDMA 2000 waveform that is currently playing. The 5 MHz setting
would not be used in any of the other ARB modulation formats or the dual ARB player. If you wereto turn
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off the CDMA 2000 ARB format and then turn it back on, the factory setting would be applied until you once
again change the ARB sample clock value. This setting can be saved to the file header. In thisway you can
set the ARB sample clock while in the ARB modulation format, and have that same setting applied when the
waveform is selected for playback in the dual ARB player.

The accessibility and setting of the ARB sample clock differs between the ARB modulation formats and the
dual ARB player. Within the ARB formats, this parameter can be changed only when the format is active
(on). Any value you enter while the format is active, will be replaced with the factory optimized value when
the format is turned off and then back on. While the ARB format is off, the ARB Sample Clock softkey is
grayed-out. In the dual ARB player, the ARB sample clock setting is accessible even when the dual ARB is
off. You can aso set the ARB sample clock when the dual ARB is off and the new setting is applied when
the dual ARB player isturned on. This setting will survive toggling the dual ARB player off and on.

Figure 4-12 on page 118 showsthe location for the ARB Sample Clock softkey which is on thefirst page of the
ARB Setup softkey menu. Even though the figureis for the ARB W-CDMA modulation format, the key path
isthe same for al ARB formats and the dual ARB player.

Waveform Markers

Waveform markers are used to mark specific points on awaveform and are available for usein all ARB
modulation formats. The signal generator provides four markers. Each marker can be associated with the RF
blanking function, the ALC hold function, and the aternate amplitude triggering function. A marker can
implement one or al three functions. For more information, refer to the section, “Using Waveform Markers’
on page 124.

NOTE In the Bluetooth modulation format, markers one and two are automatically set when
payload data types are selected and the waveform is generated. See “Bluetooth Marker
Behavior” on page 123 for more information.

You can set each marker’s polarity and the marker points (first sample point or arange of sample points).
Each marker provides arear panel output signal using the event connector (EVENT 1, 2, 3, or 4) that
corresponds to the marker number. The EVENT 3 and 4 connectors are actually pins located on the AUX
I/O connector. For more information on the AUX 1/0 connector, see“Rear Panel Overview” on page 37.

The ALC hold marker function holds the ALC modulator at its current level when the marker signal islow.
When the marker signal goes high, the ALC hold function is discontinued.

ALC hold is automatically incorporated in the RF blanking marker function. So if you select the RF
blanking marker function (Pulse/RF Blank softkey), there is no need to select the AL C hold marker function
for the same marker number. You can use the AL C hold function by itself when you have awaveform signal
that incorporates idle periods or when the increased dynamic range encountered with RF blanking is not
desired. The ALC hold should only be used for short periods of time of less than 100 ms. Extended periods
of using the ALC hold feature may affect the waveform'’s output amplitude.
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The alternate amplitude marker function triggers the Alternate Amplitude feature located in the Amplitude
hardkey menu. You still need to set up the aternate amplitude parameters. The trigger selection for the
aternate amplitude feature in the Amplitude hardkey menu should be set to internal.When the marker signal
goes low, the aternate amplitude function is triggered. When the marker signal goes high, the trigger is
terminated disengaging alternate amplitude.

Marker settings are located in the Marker Utilities softkey menu. The location of this softkey and the marker
softkey menus are shown in Figure 4-13. Even though the figureis for the ARB W-CDMA modulation
format, the key path is the same for all ARB formats and the dual ARB player.

Chapter 4 121



Basic Digital Operation (Option 001/601 or 002/602)
Local Settings for ARB Waveform Formats and the Dual ARB Player

Figure 4-13 ARB Marker Location and Softkey Menus
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Bluetooth Marker Behavior

Bluetooth markers one and two have predetermined settings that are implemented when a payload data type
is selected and the waveform is generated. A waveform is regenerated when a new payload datatypeis
selected while the modulation format is on. These predetermined settings will override the current marker
settings if they are different. However they do not affect the ALC hold and the alternate amplitude marker
functions. But they will affect the RF blanking function. After the waveform has been
generated/regenerated, you can modify the predetermined settings to suit your measurement needs. The
following list explains the predetermined settings for marker one and two according to the selected payload

datatype:

Truncated PN9 or 8-bit  Marker one outputs a five-sample-point wide pulse (500 ns) at the EVENT
pattern 1 rear pandl connector, and marker two implements RF blanking during
the time that the Bluetooth signal islow.

Continuous PN9 Marker one outputsa 1l MHz clock signal at the EVENT 1 rear panel
connector, and marker two outputs a 216 us gated pulse signa at the
EVENT 2 rear panel connector that aligns with the transmission of the
payload data.
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Using Waveform Markers

The signal generator provides four waveform markers to mark specific points on a waveform segment.
When the signal generator encounters an enabled marker, an auxiliary output signal is routed to the rear
panel event connector (described in the “Rear Panel Overview” on page 37) that corresponds to the marker
number. You can use thisauxiliary output signal to synchronize another instrument with the waveform, or as
atrigger signal to start a measurement at a given point on awaveform.

You can aso configure markersto initiate ALC hold, or RF Blanking (which includes ALC hold). Refer to
“Waveform Markers’ on page 120 for more information.

Creating a waveform segment (page 108) also creates a marker file that places a marker point on the first
sample point of the segment for markers one and two. When awaveform file is downloaded that does not
have a marker file associated with it, the signal generator creates a marker file without any marker points.
Factory-supplied segments have a marker point on the first sample for al four markers.

The following procedures demonstrate how to use markers while working in the dual ARB player, but the
process is the same when working in any ARB format.

These procedures also discuss two types of points. amarker point and a sample point. A marker pointisa
point at which a given marker is set on awaveform; you can set one or more marker points for each marker.
A sample point is one of the many points that compose a waveform.

There are three basic steps to using waveform markers;

“Clearing Marker Points from a Waveform Segment” on page 131

“Setting Marker Points in a Waveform Segment” on page 132

“Controlling Markersin a Waveform Sequence (Dual ARB Only)” on page 134

This section aso provides the following information:

*  “Waveform Marker Concepts’ on page 125

» “Accessing Marker Utilities’ on page 129

*  “Viewing Waveform Segment Markers’ on page 130

»  “Viewing aMarker Pulse” on page 136

» “Using the RF Blanking Marker Function” on page 137
o “Setting Marker Polarity” on page 139
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Waveform Marker Concepts

The signal generator’s ARB formats provide four waveform markersto mark specific points on awaveform
segment. You can set each marker’s polarity and marker points (on a single sample point or over arange of
sample points). Each marker can also perform ALC hold or RF Blanking and AL C hold.

R — J—L Positive 43 EVENT N
Marker
File > O | Marker N
Bit N RF Blank Off On
Set Marker Marker ; Marker N
E— ; Negative /
On Off Polarit | 5 BlanksRF
y O_ when Marker
: is Low
When the signal generator encounters an enabled marker (described on ' RF Blank Only: includes ALC Hold
page 134), an auxiliary output signal is generated and routed to the rear ;

Marker N
panel event connector that corresponds to the marker number (N). /5_ Holds ALC
The EVENT 3 and 4 connectors are pins on the AUXILIARY 1/O connector when Marker
(connector locations are shown in Figure on page 41). is Low

Marker N
ALC Hold Off On

Marker File Generation

Generating awaveform segment (see page 108) automatically creates a marker file that places a marker
point on the first sample point of the segment for markers one and two.

Downloading awaveform file (as described in the E4428C/38C ESG Sgnal Generators Programming
Guide) that does not have a marker file associated with it causes the signal generator to automatically create
amarker file but does not place any marker points.

Marker Point Edit Requirements

Before you can modify awaveform segment’s marker points, the sesgment must reside in volatile memory
(WFM1). Refer to the section, “Loading Waveform Segments from Non-Volatile Memory” on page 114 for
more information.

In the dual ARB player, you can modify awaveform segment’s marker points either without playing the
waveform, or while playing the waveform in an ARB modulation format. In an ARB modulation format,
you must play the waveform before you can modify a segment’s marker points.

Saving Marker Polarity and Routing Settings

Marker polarity and routing settings remain until you reconfigure them, preset the signal generator, or cycle
the ESG power. To ensure that awaveform uses the correct settings when it is played, set the marker
polarities or routing (RF Blanking and ALC Hold), and save the information to the file header (page 93).
Thisis especially important when the segment plays as part of a sequence because the previously played
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segment could have different marker and routing settings.

ALC Hold Marker Function

While you can set a marker function (described as Marker Routing on the softkey 1abel) either before or after
you set marker points (page 132), setting a marker function before setting marker points may cause power
spikes or loss of power at the RF output.

Use the AL C hold function by itself when you have a waveform signal that incorporatesidle periods, or
when the increased dynamic range encountered with RF blanking (page 137) isnot desired.

The ALC hold marker function holds the ALC circuitry at the average (RMS) value of the sampled points
set by the marker(s). For both positive and negative marker polarity, the ALC samples the RF output signal
(the carrier plus any modulating signal) when the marker signal goes high:

Positive: The signal is sampled during the on marker points.
Negative The signal is sampled during the off marker points.

The marker signal has aminimum of atwo sample point delay in itsresponse rel ative to the waveform signal
response. To compensate for the marker signal delay, offset marker points from the waveform sample at
which you want the ALC sampling to begin.

NOTE Because it can affect the waveform'’s output amplitude, do not use the AL C hold for longer than
100 ms. For longer time intervals, refer to “Power Search Mode” on page 661.

Markers set early in time
to account for marker response

RF OUTPUT ‘ : S

g
-‘r. .

=
Marker H - H
. . : == :
Positive Polarity .
E: 100 ms :E
. Max ALC hold time :
CAUTION Incorrect ALC sampling can create a sudden unleveled condition that may create aspikein

the RF output, potentially damaging aDUT or connected instrument. To prevent this
condition, ensure that you set markersto let the ALC sample over an amplitude that
accounts for the higher power levels encountered within the signal.
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Example of Correct Use

Waveform: 1022 points
Marker range: 95-97
Marker polarity: Positive

This example shows a marker set to sample the waveform'’s area of

highest amplitude. Note that the marker is set well before the

waveform’s area of lowest amplitude. This takesinto account the
response difference between the marker and the waveform signal.

The AL C samples the waveform when the marker signal goes
high, and uses the average of the sampled waveform to set the
ALC circuitry.

Here the ALC samples during the on marker points (positive
polarity).

Example of Incorrect Use

Waveform: 1022 points
Marker range: 110-1022
Marker polarity: Positive

This example shows a marker set to sample the low part of the
same waveform, which sets the ALC modulator circuitry for
that level; this usually resultsin an unleveled condition for the
signal generator when it encounters the high amplitude of the
pulse.

Close-up of averaging

Pulse Unleveled
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Example of Incorrect Use

Waveform: 1022 points
Marker range: 110-1022
Marker polarity: Negative

This figure shows that a negative polarity marker goes low during
the marker on points; the marker signal goes high during the off
points. The ALC samples the waveform during the off marker

points.
Sample range begins on first point of signal

Sampling both on and off time sets the modulator circuitry
incorrectly for higher signal levels. Note the increased amplitude
at the beginning of the pulse.

Negative range set between signal and
off time
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Use the following procedure to display the marker parameters. This procedure uses the dual ARB player, but
you can access the marker utilities through the ARB Setup softkey in all ARB formats.

1. Select the ARB waveform player:
press Mode > Dual ARB
2. Press ARB Setup > Marker Utilities.
ARE Sample Clock
100-0000000 TH=
iavetorm? ARB Bsforance
Haveform,)
Seoments
Haveform,
Sequences UpEyeform, Marker Polaritus
ARE Setup > Mark )
Utilities P |  Marker Routinoy When using an ARB format other than
Tricger dual ARB, you must turn on the format
(Cont inuods )™ Ut TR & narkers.>/to enable the Set Markers softkey.
More
(1 of 2)
NOTE Most of the procedures in this section begin at the Marker Utilities softkey menu.
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Viewing Waveform Segment Markers

Markers are applied to waveform segments. Use the following steps to view the markers set for a segment

(this example uses the factory-supplied segment, SI NE_TEST |

1. Inthe Marker Utilities menu (page 129), press Set Markers.

VEN).

2. Highlight the desired waveform segment. In an ARB format such as Custom Arb Waveform Generator,
thereisonly one file (AUTOGEN WAVEFCRM) and it is highlighted.

3. PressDisplay Markers > Zoom in Max. The maximum zoom in range is 28 points.

Experiment with the Zoom functions to see how they display the markers.

The display can show a maximum of 460 points; displayed waveforms with a sample point range greater

than 460 points may not show the marker locations.
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Clearing Marker Points from a Waveform Segment

When you set marker points they do not replace points that already exist, but are set in addition to existing
points. Because markers are cumulative, before you set points, view the segment (page 130) and remove
any unwanted points. With all markers cleared, the level of the event output signal is OV.

Clearing All Marker Points

1
2.

5.

In the Marker Utilities menu (page 129), press Set Markers.

Highlight the desired waveform segment.
In an ARB format, there is only one file (AUTOGEN WAVEFCRM) and it is already highlighted.

Highlight the desired marker number:
Press Marker 12 3 4.

For the selected marker number, remove all marker points in the selected segment:
Press Set Marker Off All Points.

Repeat from Step 3 for any remaining marker points that you want to remove.

Clearing a Range of Marker Points

The following exampl e uses awaveform with marker points (Marker 1) set across points 10-20. This makes
it easy to see the affected marker points. The same process applies whether the existing points are set over a
range or asindividual points (page 125).

1
2.

In the Marker Utilities menu (page 129), select the desired marker (for this example, Marker 1).

Set the first sample point that you want off (for this example, 13):
Press Set Marker Off Range Of Points > First Mkr Point > 13 > Enter.

Set the last marker point in the range that you want off to avalue less than or equal to the number of
points in the waveform, and greater than or equal to the value set in Step 2 (for this example, 17):
Press Last Mkr Point > 17 > Enter > Apply To Waveform > Return.

Thisturns off al marker points for the active marker within the range set in Steps 2 and 3, as shown in
the following figure.

Arb laveform Markers
UFITL :RAMP_TEST_UFTI

F WM O

1 Sample Point 28

Viewing markers is described on page 130
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Clearing a Single Marker Point

Use the steps described in “Clearing a Range of Marker Points’ on page 131, but set both the first and last
marker point to the value of the point you want to clear. For example, if you want to clear a marker on point
5, set both the first and last value to 5.

Setting Marker Points in a Waveform Segment

To set marker points on a segment, the segment must reside in volatile memory (page 114).

When you set marker points, they do not replace points that already exist, but are set in addition to existing
points. Because markers are cumulative, before you set marker points within a segment, view the segment
(page 130) and remove any unwanted points (page 125).

Placing a Marker Across a Range of Points

1. Inthe Marker Utilities menu (page 129), press Set Markers.

2. Highlight the desired waveform segment.
In an ARB format, there is only one file (AUTOGEN WAVEFCRM) and it is already highlighted.

3. Highlight the desired marker number:
Press Marker 123 4

4. Setthefirst sample point in the range (in this example, 10):
Press Set Marker On Range Of Points > First Mkr Point > 10 > Enter.

5. Set thelast marker point in the range to a value less than or equal to the number of pointsin the
waveform, and greater than or equal to the first marker point (in this example, 20):

Press Last Mkr Point > 20 > Enter.
6. Press Apply To Waveform > Return.

This sets arange of waveform marker points. The marker signal starts on sample point 10, and ends on
sample point 20, as shown in the following figure.

Arb laveform Markers
UFITL :RAMP_TEST_UFTI

F WM O

1 Sample Point 28

Viewing markers is described on page 130
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Placing a Marker on a Single Point

On the First Point

1. Inthe Marker Utilities menu (page 129), press Set Markers.

2. Highlight the desired waveform segment.
Inan ARB format, there is only one file (AUTOGEN WAVEFCRM) and it is already highlighted.

3. Highlight the desired marker number:

Press Marker 12 3 4.
4. Press Set Marker On First Point.

This sets amarker on the first point in the segment for the marker number selected in Step 3.
On Any Point

Use the steps described in “ Setting Marker Pointsin a Waveform Segment” on page 132, but set both the
first and last marker point to the value of the point you want to set. For example, if you want to set a marker
on point 5, set both the first and last value to 5.

Placing Repetitively Spaced Markers

The following example sets markers across a range of points and specifies the spacing (skipped points)
between each marker. You must set the spacing before you apply the marker settings; you cannot apply
skipped pointsto a previously set range of points.

1. Remove any existing marker points (page 125).
2. Inthe Marker Utilities menu (page 129), press Set Markers.

3. Highlight the desired waveform segment.
In ARB formats there is only one file (AUTOGEN WAVEFCRM) and it is already highlighted.

4. Highlight the desired marker number: Press Marker 12 3 4.

5. Set the first sample point in the range (in this example, 5):
Press Set Marker On Range Of Points > First Mkr Point > 5 > Enter.

6. Set thelast marker point in the range to a value less than the number of pointsin the waveform, and
greater than or equal to the first marker point (in this example, 25):
Press Last Mkr Point > 25 > Enter.

7. Enter the number of sample points that you want skipped (in this example, 1):
Press # Skipped Points > 1 > Enter.

Chapter 4 133



Basic Digital Operation (Option 001/601 or 002/602)
Using Waveform Markers

8. Press Apply To Waveform > Return.

This causes the marker to occur on every other point (one sample point is skipped) within the marker point
range, as shown below.

Arb laveform Markers
UFITL :RAMP_TEST_UFTI

F WM O

1 Sample Point 28

Viewing markers is described on page 130

One application of the skipped point feature is the creation of aclock signal asthe auxiliary output.

Controlling Markers in a Waveform Sequence (Dual ARB Only)

In awaveform segment, an enabled marker point generates an auxiliary output signal that is routed to the
rear-panel event connector (described in “ Rear Panel Overview” on page 37) corresponding to that marker
number. For awaveform sequence, you enable or disable markers on a segment-by-segment basis; this
enables you to output markers for some segments in a sequence, but not for others. Unless you change the
marker settings or cycle the power, the setting remains the same for the next |oaded sequence.

As You Create a Waveform Sequence

After you select the waveform segments to create a waveform sequence, and before you name and save the
seguence, you can enable or disable each segment’s markers independently. Enabling a marker that has no
marker points (page 132) has no effect on the auxiliary outputs.

1. Select the waveform segments (Step 1 on page 109).
2. Toggle the markers as desired:

a. Highlight the first waveform segment.

b. PressEnable/Disable Markers.

c. Asdesired, press Toggle Marker 1, Toggle Marker 2, Toggle Marker 3, and Toggle Marker 4.
Toggling a marker that has no marker points (page 132) has no effect on the auxiliary outputs.

Anentry inthe Mkr column (see figure below) indicates that the marker is enabled for that segment;
no entry in the column meansthat all markers are disabled for that segment.

d. Inturn, highlight each of the remaining segments and repeat Step c.

3. PressReturn.
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4. Name and store the waveform sequence “ Storing Waveform Segments to Non-Volatile Memory” on
page 113.

The following figure shows a sequence built reusing the same factory-supplied waveform segment; a
factory-supplied segment has amarker point on the first sample for al four markers. In this example,
Marker 1 is enabled for the first segment, Marker 2 is enable for the second segment, and markers 3 and 4
are enabled for the third segment.

Togole Marker 3
STME_TEST_MFM|  CUNSTORED) UNTITLED S Marker Col
(1/2) 5 t 5 e| (1/1) Uaveforn  Repst/fikr equence Marker Column
AUTOGEN_PRAM_1 2KKLZKKM WML SINE_TEST_WFHM 1l Togale Marker L .
RAMP_TEST_LFH A WFF1:SINE_TEST_HFH 1]z This entry shows that
STHE_TEST_UFN ARZ LIFML: STNE ZTEST T @D ) markers 3 and 4 are enabled
EDHPLEE for this segment.

For each segment, only the markers enabled for that segment produce arear-panel auxiliary output signal. In
this example, the Marker 1 auxiliary signal appears only for the first ssgment, because it is disabled for the
remaining segments. The Marker 2 auxiliary signal appears only for the second segment, and the marker 3
and 4 auxiliary signals appear only for the third segment.

In an Existing Waveform Sequence

If you have not already done so, create and store a waveform segquence that contains at least three segments
(page 109). Ensure that the segment or segments are available in volatile memory (page 114).

1. PressMode > Dual ARB > Waveform Sequences, and highlight the desired waveform sequence.
2. PressEdit Selected Waveform Sequence, and highlight the first waveform segment.

3. PressEnable/Disable Markers > Toggle Marker 1, Toggle Marker 2, Toggle Marker 3, and Toggle Marker 4.
Toggling a marker that has no marker points (page 132) has no effect on the auxiliary outputs.

Anentry inthe Mkr column indicates that the marker is enabled for that segment; no entry in the column
means that all markers are disabled for that segment

4. Highlight the next waveform segment and toggle the desired markers (in this example, markers 1 and 4).

Repeat Step 4 as desired (for this example, select the third segment and toggle marker 3).
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6. PressReturn > Name And Store > Enter.

The markers are enabled or disabled per your selections, and the changes have been saved to the selected
sequence file.

FRELUENCY AMPLITUDE Tnsert
4.000 000000 00 &xz | ~136.00 den o=iecten tmveorn
rion
(i /Sequence Marker Column
RAIP_TEST_WFI1|  (UNSTORED) UNTITLED /
(1/1) _ Segment 8 e| (/1) Uaveforn _Repsty ik
UFNL RANP_TEST_UFN 1fizay| Done Inserting
HFML:SINE_TEST LN 1 u

0_ SEQ:RO_DATA N
TGR_TST_2 SeueForm' )
T5T_GW \Th|s entry shows that only

marker 3 is enabled for this

Page U
ma= SR segment.

Fage Down

=22 PROTO CODE == NOT FOR CUSTOMER USE ss=s 01,/21/2070 19:39

Viewing a Marker Pulse

When awaveform plays (page 110), you can detect a set and enabled marker’s pulse at the rear panel event
connector that corresponds to that marker number. This example demonstrates how to view a marker pulse

generated by awaveform segment that has at least one marker point set (page 132). The processisthe same
for awaveform seguence.

This procedure uses the factory-supplied segment, SI NE_TEST _WMin the dual ARB Player.
Factory-supplied segments have a marker point on the first sample point for al four markers, as shown.

Arb laveform Markers
UFITL :STHE_TEST_UFTI

Marker points on
first sample point of
waveform segment

Fowm ;\’6 -
[

Sample Point 28

Viewing markers is described on page 130
1. PressMode > Dual ARB > Select Waveform, and highlight the S| NE_TEST WFMsegment.
2. Press ARB 0ff On to On.
3. Connect the ESG's rear-panel Q QUT output to the oscilloscope’s channel 1 input.
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4. Connect the ESG's rear-panel EVENT 1 output to the oscilloscope’s channel 2 input. When marker 1is
present, the ESG outputs a signal on the EVENT 1 connector as shown in the following example.

RF Output

Marker pulse on the Event 1 signal.

Using the RF Blanking Marker Function

While you can set a marker function (described as Marker Routing on the softkey label) either before or after
setting the marker points (page 132), setting a marker function before you set marker points may change the
RF output. RF Blanking includes AL C hold (described on page 126, note Caution regarding unleveled
power). The signal generator blanks the RF output when the marker signal goes low.

1. Using the factory-supplied segment SI NE_ TEST WM set Marker 1 across points 1-180 (page 132).
2. From the Marker Utilities menu (page 129), assign RF Blanking to Marker 1:
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Press Marker Routing > Pulse/RF Blank > Marker 1.

RF Signal

/

¥ || |

|| || ||| ] || ||| | || | LHM—~| | || |

| | ||||| || |||||| IIIIII || || II| ”
AN

L PPN SR P S S — |

180
|- Segment—— |

Marker Polarity = Positive

When marker polarity is positive (the
default setting), the RF output is blanked
during the off maker points.

ov

Marker Polarity = Negative

When marker polarity is negative, the
RF output is blanked during the on
maker points

ov
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Setting Marker Polarity
Setting a negative marker polarity inverts the marker signal.

1. Inthe Marker Utilities menu (page 129), press Marker Polarity.

2. Select the marker polarity as desired for each marker number.

Marker Polarity p1EKE" 1N281%

Default Marker Polarity = Positive

Marker Routingh Marker ENESlalﬁr“it o
Set each marker polarity independently.

Set Markersh Marker SNESlariti

Marker L Polarit
Heg lﬁ

See Also: “Saving Marker Polarity and Routing Settings” on page 125.

|
As shown on page 137:
Positive Polarity:  On marker points are high (=3.3V).
Negative Polarity: On marker points are low (OV).
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Triggering Waveforms

Triggering is available in both ARB and real time formats. ARB triggering controls the playback of a
waveform file; real time custom triggering controls the transmission of a data pattern. The examples and
discussionsin this section use the dual ARB Player, but the functionality and methods of access (described
on page 142) are similar in al ARB and real time formats.

Triggers control datatransmission by telling the ESG when to transmit the modulating signal. Depending on
the trigger settings, the data transmission may occur once, continuously, or the ESG may start and stop the
transmission repeatedly (Gated mode).

A trigger signal comprises both positive and negative signal transitions (states), which are aso called high
and low periods; you can configure the ESG to trigger on either state. It iscommon to have multipletriggers,
also referred to as trigger occurrences or trigger events, occur when the signal generator requires only a
single trigger. In this situation, the ESG recognizes the first trigger event and ignores the rest.

When you select atrigger mode, you may lose the signal (carrier plus modulation) from the RF output until
you trigger the modulating signal. Thisis because the ESG setsthe | and Q signalsto zero volts prior to the
first trigger event, which suppresses the carrier. If you create a data pattern with the initial 1 and Q voltages
set to values other than zero, this does not occur. After thefirst trigger event, the signal’sfinal | and Q levels
determine whether you see the carrier signal or not (zero = no carrier, other values = visible carrier). At the
end of most data patterns, the final | and Q points are set to a value other than zero.

There are four parts to configuring awaveform trigger:

*  Source determines how the ESG receives the trigger that initiates waveform play.

* Mode determines the waveform’s overall behavior when it plays.

* Response determines the specifics of how the waveform responds to a trigger.

» Polarity determines the state of the trigger to which the waveform responds (used only with an external
trigger source); you can set either negative, or positive.
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Source

The figure below sho